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Message from M&E advisor, HIV/AIDS Services Project 

 

The Ministry of Health and Social Welfare (MOHSW), with its support from The Japan International 

Cooperation Agency (JICA), has commenced a four-year project entitled “Health Systems Strengthening 

for HIV and AIDS Services Project” since October 2010.  One of the components of the project is to 

strengthen the HIV and AIDS Monitoring and Evaluation (M&E) system through modeling exercises in 

Dodoma and Pwani regions.  

 

M&E system of the project is composed of the data feedback and data utilization. Data have to be 

returned to the data source with an interpretation after being analyzed and visualized in order for the 

people who collect the data to understand the situation of their community. The findings of the data 

analysis are expected to be utilized to improve the health services by the health management teams.  

 

Although the concept is quite unique and challenging to all of you, we hope that the knowledge and 

skills acquired through this training will be applied to your routine work once you return to your field. 

 

Eventually that all the efforts will come together to improve the health services in your community. 

 

 

September 2012 

 

TANAKA, Ayuko Dr.PH, MPH, MSc 

Epidemiologist/ M&E Advisor 

Health Systems Strengthening for HIV and AIDS Services Project 
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Course Description 

The course is made particularly to strengthen the capacity of data analysis and data feedback at 

Regional Health Management Teams and Council Health Management Teams by use of MS Excel 2010. 

Among a number of HIV/ AIDS related indicators, Score Card Indicators selected by National AIDS 

Control Programme will be applied as data. Throughout the course, participants will be guided to the 

process to analyze and visualize their data timely and accurately. 

 

Course Objectives  

At the end of the course, students should be able to 

1) Maintain IT equipment properly 

2) Comprehend the basic MS Excel functions 

3) Acquire the skills of making tables and charts through MS Excel 

4) Acquire the skills of statistical data analysis through MS Excel 

5) Analyze data by use of Score Card Indicators 

6) Produce data feedback materials for health facilities by use of Score Card indicators 
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Lesson Plan of Computer Course Programme – Data analysis and Production of feedback materials 

Tutor: DAUDI MLAULE AND JUMA HANZURUNI for Basic & Intermediate     
Objectives: The students will be introduced to concepts of Information Technology and be able to start, use, shutdown and maintain the computer 

properly, be able to work in spreadsheets, formatting and laying out data and carry out statistical and mathematical calculations to a level 
matching to their needs and abilities, and be able to make feedback material based on above mention skills and knowledge 
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Day Topic Teacher Activity  Learner Activity  Resources

Day1 1.PC General instruction and Proper Maintenance Exercises on PC General instruction and Proper Maintenance

Information Technology concepts.

Hardware Management to Improve System performance.

Introduction to Computer and its parts including Keyboard and  Mouse, how they work and maintain them.

Starting, restarting, hibernating, standby and shutting down the computer, adjustment.

Folder & file management (creating, copying , renaming, moving, erasing, restoring and search).

Data storage & backup (HD, external HD, USB memory flash etc.).

Managing User Accounts.

Creating, Changing account type, setting and removing passwords, Erasing accounts. Definition and Application of AntiVirus.

2.Introduction to spreadsheet program (MS Excel ver. 2010/ Windows 7)  "What is MS Excel? "

<Managing Workbook> Creating, Saving, copying, renaming, moving, erasing workbooks. Exercises on Managing Workbook

<Managing Worksheet> Creating/inserting, copying, renaming, moving, erasing worksheets and tab color worksheets. Exercises on Managing Worksheet

Screen structure ( title-bar, menu-bar, row number, column number, scroll-bar, clip board, status-bar, formula bar, cell and active cell, mouse pointer, name box, 

question box, worksheet-tab, minimize button, maximize and restore down button, close button, help button etc.)

Navigating menu using a mouse and keyboard.

Entering, Copying, Cutting, Pasting the data and maintaining them on the worksheet using clip board and short-cut key.

Inserting rows and columns, Adding borders and filling color, Formatting cells and Conditional formatting, if functions and lookup formulas. Exercises and Tests on basic operation of PC and MS Excel

Day2 1.Introduction to making  "MS Excel Database" and its basic theory. " What is Excel database? " Exercise on how to make a database

2.Introduction to basic formulas (addition, subtraction, division, multiplication, exponentiation, sum, count) Exercises on how to work with basic formula and tabulation

3.Introduction to basic statics values (Mean, Standard error, Median, Mode, Rage, Maximum, Minimum, Standard deviation ) Exercise on creating Excel table by formatting borders and shading and deleting a table

4.Introduction to tabulation using MS Excel Exercise on formatting and printing a table

5.Introduction to making  tables in MS Excel and its basic theory.  "What is table ? " Exercises and Tests on creating a table using tabulating data

Day3 1.Introduction to graphing data and its basic theory. "What is graph/chart ? " Exercise on selecting and creating suitable graph/chart based on purpose

Types of graph/chart and concept of each graph/chart e.g. Columns, Bar, XY and others Exercise on formatting and printing graph/chart

2.Introduction to Data Analysis using MS Excel.  "What is data analysis ? "

Analyzing data in MS Excel and explaining what they mean. 

Exercises on how to work with Correlation Coefficient, Scatter chart and Regression formula 

and Hypothesis testing

3.Introduction to Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing e.g. t-test and z-test, Once comfortable carry 

out additional tasks supplied by the tutor 

Exercises and Tests on creating graph/chart and how to work with Correlation Coefficient, 

Scatter chart and Regression formula and Hypothesis testing

Day4 1.Introduction to making presentation format in MS Excel Exercises on producing feedback materials 

Organizing table, graph/chart and description in A4 paper, printing them out as feedback materials

2.Facilitation for producing feedback materials Production of feedback materials using own SCI data 

Day5 1.Facilitation for producing feedback materials Production of feedback materials using own SCI data 

Presentation of produced  feedback materials

2.Suggestion with encouragements on the presented materials Suggestion with encouragements on the presented materials
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Whiteboard

How-to manual on Excel 

Interactive whiteboard

Digital Projector

Additional exercises on 

covered items

Pictorial handout on menus 

and their meanings

Color Printer & printing 

paper 

Physical parts of computer 

(e.g.HDD, RAM, CPU, 

Case, and Motherboard 

etc.)

Whiteboard

Digital Projector

Practical exercises

Color Printer & printing 

paper 
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TIME TABLE 
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Day Start

Time

End

Time

Activity/Topic Responsible Person

Day 1 8:00 8:30 Participants arriving and registration All

8:30 9:00 Opening Remarks, logistics, Self-Introduction, Training schedule UCC Arusha Branch Manager, NACP/JICA

representative

JICA HIV/AIDS M&E activities and Purpose of the training, Today's target and schedule NACP/JICA representative

9:00 10:30 PC General instruction and Proper Maintenance Daudi Mlaule and Juma Hanzuruni

Introduction to Computer and its parts including Keyboard and  Mouse, how they work and maintain them

Starting, restarting, hibernating, standby and shutting down the computer, adjustment),  Folder & file management (create,  copying , renaming, moving, erasing,

restoring and search), Data storage & backup (HD, external HD, USB memory flash), Desktop management (Taskbar setting, Screen Wallpaper, Screen Saver,

Clock adjustment)

Optimizing computer performance by Disk defragmentation, error checking and cleanup

10:30 11:00 Tea Break All

11:00 13:00 Managing User Accounts Daudi Mlaule and Juma Hanzuruni

Creating, Changing account type, setting and removing passwords, Erasing accounts. Definition and Application of AntiVirus Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Introduction to spreadsheet program (MS Excel ver. 2010)  "What is Excel? " Daudi Mlaule and Juma Hanzuruni

Worksheet and Workbook, Screen structure ( title-bar, menu-bar, row number, column number, scroll-bar, clip board, status-bar, formula bar, cell and active cell,

mouse pointer, name box, question box, worksheet-tab, minimize button, maximize and restore down button, close button, help button etc.), Navigating menu using

a mouse and keyboard

Creating, Saving, copying, renaming, moving, erasing workbooks

Entering, Copying, Cutting, Pasting the data and maintain them on the worksheet using clip board and short-cut key

Inserting rows and column, Adding borders and filling color, Formatting cell and Conditional formatting, if functions and lookup formula.

Creating/inserting, copying, renaming, moving, erasing worksheets and tab color worksheets

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on basic operation of PC and MS Excel Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 2 8:00 9:00 Recap for day 1 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:30 Introduction to making a "MS Excel Database" and its basic theory. " What is Excel database? " Daudi Mlaule and Juma Hanzuruni

Exercise on how to make a database Students/Participants

Introduction to basic formula (addition, subtraction, division, multiplication, exponentiation, sum, count) Daudi Mlaule and Juma Hanzuruni

Introduction to basic statics values (Mean, Standard error, Median, Mode, Rage, Maximum, Minimum, Standard deviation ) do

Introduction to tabulation using MS Excel do

Exercises on how to work with basic formula and tabulation Students/Participants

10:30 11:00 Tea Break All

11:00 13:00 Introduction to making  tables in MS Excel and its basic theory.  "What is table ? " Daudi Mlaule and Juma Hanzuruni

Exercise on creating Excel table by formatting borders and shading and deleting a table Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Exercise on formatting and printing a table Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on creating a table using tabulating data Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants
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Day Start

Time

End

Time

Activity/Topic Responsible Person

Day 3 8:00 9:00 Recap for day 2 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:30 Introduction to graphing data and its basic theory. "What is graph/chart ? " Daudi Mlaule and Juma Hanzuruni

Types of graph/chart and concept of each graph/chart do

Exercise on selecting and creating suitable graph/chart based on purpose Students/Participants

10:30 11:00 Tea Break All

11:00 13:00 Exercise on formatting and printing graph/chart Students/Participants

Introduction to data analysis using MS Excel.  "What is data analysis ? " Daudi Mlaule and Juma Hanzuruni

13:00 14:00 Lunch Break All

14:00 15:30 Introduction to Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Daudi Mlaule and Juma Hanzuruni

Exercises on how to work with Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on creating graph/chart and how to work with Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 4 8:00 9:00 Recap for day 3 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:00 What is data feedback ? NACP/JICA representative

10:00 10:30 How to produce feedback materials using MS Excel Daudi Mlaule and Juma Hanzuruni

10:30 11:00 Tea Break All

11:00 13:00 Exercises on produce feedback materials Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Exercises on producing feedback materials (Continued….) Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Produce feedback materials using own SCI data Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 5 8:00 8:30 Recap for day 4 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

8:30 9:30 Produce feedback materials using own SCI data (Continued….) Students/Participants

9:30 10:30 Presentation of produced materials Students/Participants

10:30 11:00 Tea Break All

11:00 11:30 Suggestion with encouragements on the presented materials Daudi Mlaule and Juma Hanzuruni

Students/Participants11:30 13:00 Final Examinations Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Discuss the way of data feedback. Students/Participants

The way forward of the project activities NACP/JICA representative

15:30 16:00 Evaluation of the training Students/Participants

16:00 16:30 Course Summary Daudi Mlaule and Juma Hanzuruni

16:30 17:00 Evening Tea All

17:00 18:00 Getting Final examination results and Certificate *for all participants and for who passed the examination Students/Participants and facilitator

Closing All
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Abbreviations & Terminology 
 

ITEM  MEANING 

ADSL  Asymmetric Digital Subscriber Line 

Bit  1 or 0 level of storage is called a bit 

BPS  Bits Per Second 

Byte  A measurement of storage capacity 

CBT  Computer Based Training 

CD  Compact Disk 

CD-R  Compact Disk - Recordable 

CD-ROM  Compact Disk - Read Only Memory 

CPU  Central Processing Unit 

DAT  Digital Audio Tape 

DOS  Disk Operating System 

DSL  Digital Subscriber Lines 

DVD  Digital Versatile Disk 

FTP  File Transfer Protocol 

G Byte  Gigabyte. A gigabyte consists of 1024 M Bytes 

G Hz  Measurement of computer speed. Gigahertz 

GUI  Graphical User Interface 

Hz  Hertz (this is a measurement of frequency (i.e. speed). 

IS  Information Systems 

ISDN  Integrated Services Digital Network 

IT  Information Technology 

K Byte  Kilo byte. A kilobyte (KB) consists of 1024 bytes. 

LAN  Local Area Network 

M Byte  Megabyte. A megabyte (MB) is one million bytes 

MHz  Million Hertz 

PC  Personal Computer 

PSTN  Public Switched Telephone Network 

RAM  Random Access Memory 

ROM  Read Only Memory 

ROM-BIOS  Read Only Memory - Basic Input Output System 

RSI   Repetitive Strain Injury 

T Byte  Terabyte. A terabyte (TB) is one million M Bytes 

UPS  Uninterruptible Power Supply 

USB  Universal Serial Bus 

VDU  Visual Display Unit 

WAN  Wide Area Network 

WWW  World Wide Web 

vi 
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Using Computer 

Starting the Computer 

 
• Ensure that all cables are plugged securely into the rear of the machine. 
• Make sure that there is no disk inserted in the CD/DVD drive. 
• Locate the power switch and turn the computer on. 
• After a few seconds, you should see something on screen. If not ensure that the monitor is switched on. 
 
 
SHUTTING DOWN THE COMPUTER 

  
  
 
 
 
• Click “Start” button 
• Click “Shut down” 
 
 

To shut down a computer 
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PARTS OF THE WINDOW 

 Make sure that you can identify: 

o Office Button 

 

o Quick Access Toolbar 

 

o Title Bar 
 

o WINDOW CONTROL BUTTONS 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

SAVING A FILE TO DISK 

 When you use a Microsoft application, such as Word, PowerPoint or Excel, 
then by default the files that you save will be saved in a folder called 
“Documents” 
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DEFINING A FILE AND A FOLDER 

 File: 

 Is electronic information stored in a computer 

 Types of files 

 Program files: All files used to run the system 

 User files: Stored in Application software e.g. Ms Excel. 

 Folder: 

 Is a virtual space in the storage drive to store files and/or other folders.  

 Is a collection of files stored in the same location in a drive. 

 
 
CREATING A FOLDER AND A FURTHER SUB-FOLDER 
  

 Open the Windows Explorer 

 Then click on the portion of the folder tree you 
would like to create a subordinate folder. 

 Under the title bar click “New Folder” 

 Write the folder name and press Enter key 

 
  
VIEWING CONTENTS IN DIFFERENT STYLES 
 

 The appearance of the Explorer contents window may be 
customized to display file and folder objects in eight 
different views 

 Select the desired view 

 Right-click the file or folder to be renamed. 

 From the drop-down menu, select the “Rename” command 

 Enter new name and press Enter key to confirm the change. 
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SELECTING FILES or FOLDERS 

 

• To select adjacent files/folders; select in combination with 
“shift key” 

• To select non-adjacent files/folders; select in combination 
with the “control key” 

• Copying files or folders between folders and between 
drives 

Use either “Copy and Paste” or use “Drag and Drop” 
technique 

• To copy (Within a drive) 

Drag and drop a file or folder while keeping the control 
(CTRL) key pressed 

 
MOVING FILES 
 

• Use either "Cut and Paste" / Use "drag and drop" techniques 

• To Move (within a drive) 

Drag and drop file or folder 
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Security Issues 

Computer logon user name (ID) and password. 
Passwords:  
If your computer has a password that prevents other users from accessing it then do NOT give this password 
to anybody else. Do not write the password on a card and prop this up next to the monitor and above all do 
not attempt to hide your access passwords on the underside of your desk (this is the first place most criminals 
would look if trying to break into your system). Make sure you do not forget your passwords; in many cases, 
data cannot be recovered once the password is lost. 
 
User IDs and passwords:  
A User ID is normally used to logon to a computer, or computer network. It uniquely identifies you to the 
network. In addition you use a password that is only known to you. The password guarantees that no one can 
access the network and impersonate you (in theory). Once you have logged on (i.e. connected) to the rest of 
your computer network, you will have been assigned access rights to the network. Your network 
administrator will have defined these access rights. The idea of access rights is that you only have the ability to 
connect to, or share, devices that you have authority to use. In other words, the network administrators often 
have access rights to just about every computer, printer, modem etc. on the network. You on the other hand 
may have access rights to print to only certain, specified printers and you may be able to access only certain 
data held on the network. 
 
Passwords: 
Your password is the only thing that will prevent someone else logging into a computer using your user ID and 
impersonating you. It is important to choose a password that cannot be easily guessed by other people. 
Ideally a password should be at least 8 characters long & contain a mixture of words and numbers. It is also 
recommended that you change your password regularly; some computer systems will require you to change 
your password periodically.  Never share your password with others 
These are procedures to create an account. Click “Start/Windows” logo then click “Control Panel”. Within this 
choose “User Accounts”. Then click “Manage another account”, a panel will open for you to see different 
present accounts. Click “Create new Account”, give it a name, decide whether is to be “Standard” or 
“Administrator” user, then click “Create Account” 
To set a password do the following; Double-click that newly made account, then click “Create a password”. 
Write your desired password and repeat it to confirm at an area given. Password hint is an optional and may 
help you to remember your password. Password Hint is visible even to other computer users. Then click 
“Create Password” 
 
It is no good backing up your data only to leave the item, you backed up to next to the computer; if someone 
steals your computer it is likely that they will also steal your backups too. If you have a fire, then again you will 
lose your backups if the backups are stored next to the computer. Ideally, backups should be stored off-site at 
a safe location. At the very least, consider storing your backups in a fireproof safe, which will give some 
protection against fire damage. 
 
The need for backups: 
The most important thing which you store on your computer is information. Often the contents of a hard disk 
can represent years of work. If the hard disk stops working one day you could lose all those years of work. For 
this reason it is VITAL that you take regular backups of the information that is stored on the computer. In 
large organisations this backup procedure is normally performed automatically by your computer support 
team, where the data is normally held on a centralised, networked computer. 
 
In smaller organisations, it is often up to the individual to organise some sort of data backup. If nothing else is 
available, copy your files to a USB memory stick or CD/DVD disk and make sure that these backups are stored 
away from the computer, ideally off-site. If there is a fire and your office burns down, if your backup disks are 
stored next to the computer they too will be incinerated. 
Disk Clean up-Help in removing unnecessary files from the Hard drive. Follow this procedure; Open “Computer” 
icon on desktop and right-click a drive you want to clean, e.g. C:  after right-clicking click ‘Properties” and 
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under “General” tab click” Disk Clean up”. The computer will calculate the amount of disk space to be freed 
and will give you an option to remove. 
 
Organizing your computer for better backups 
When you think about it, you have a computer containing many programs and also a large amount of data 
that you have created, then it is only the data that really needs to be backed up. If you create a folder 
structure that contains only data then only this folder (plus any sub-folders of this folder) needs to be backed 
up. 
 
Complete vs. incremental backups 
A complete backup means that you backup all the data on your computer. This has the advantage that the 
entire hard disk can be backed up, but suffers from the disadvantage that this process can take a long time if 
your computer contains a lot of data. An incremental backup means that once a week you can perform a 
complete backup, but every night for the rest of the week, you only backup files that have been newly created 
or modified since the last backup, saving time. With the right backup software, this process is automatic, and 
normally you only have to select full or incremental. 
 
Firewalls 
A firewall is a system that secures your network from access by unauthorized users. A firewall can be 
implemented via software, hardware or by a combination of the two. If you are using broadband for Internet 
access, it is vital that some sort of firewall is in place to stop people trying to hack into your computer. 
 
Computer viruses 
Viruses are small programs that hide themselves on your disks (both diskettes and your hard 
disk). Unless you use virus detection software, the first time that you know that you have a 
virus is when it activates. Different viruses are activated in different ways. BEWARE: Viruses 
can destroy all your data. 
 
 Viruses hide on a disk and when you access the disk (either a diskette or another hard disk over a network) 
the virus program will start and infect your computer. The worst thing about a computer virus is that it can 
spread from one computer to another, either via the use of infected disks, or over a computer network. The 
Internet allows you to access files from all over the world and you should never connect to the Internet unless 
you have a virus-checking program installed on your computer. It is vital to keep your virus monitoring 
software up to date. Many anti-virus programs, such as Norton Anti-Virus allow you to update the program so 
that the program can check for recently discovered viruses. 
 
More Information: 
McAfee Anti-virus software http://www.mcafee.com 
Norton Anti-virus software http://www.symantec.com/avcenter 
AVG anti-virus software http://www.grisoft.com/ 
Microsoft Essential Security Anti-virus software  
http://windows.microsoft.com/en-US/windows/products/security-essentials 

There are many ways in which a virus can infect your computer.  A very common way that viruses gain access 
to a computer, is when people download files from the Internet.  Never download files from a website unless 
you are sure that the website can be trusted.  Many anti-virus products now rate websites and mark those 
that are known to distribute viruses, with a warning.   

For the same reason you should never open an e-mail attachment unless the e-mail has come from a trusted 
source.   

Another common route of virus infection is by attaching portable storage disks to your computer that have 
been supplied to you.  In most cases, good up-to-date virus checking software should offer you pretty good 
protection against catching a virus when downloading or sharing files.   

In many organisations, attaching an un-authorised storage device to a computer is an offence that can result 
in dismissal from the organisation.   
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The safest way to use a computer is to not connect it to a Local Area network or the Internet. This is called a 
'stand-alone' computer, providing that you do not use disks on that PC that have been used in other 
computers, this type of computer is virtually immune from any form of intrusion. 

Unfortunately it is the ability to connect to other computers or indeed the Internet, that makes the modern 
computer so versatile and so useful. 

Always make sure that all computers require an ID and password to access them. Make sure that all relevant 
'security patches' from Microsoft have been applied. 

Make sure that the password is long enough, contains a random mixture of numbers and letters, and that the 
passwords are changed on a regular basis.  

There are many examples, where people have used passwords that relate to something personal, such as a 
partner’s first name, the dog’s or cat’s name, etc. For a determined, serious computer hacker, these are easy 
to guess. If you have a system, where lots of different passwords are required to access the system, then 
security often breaks down and computer users will sometimes keep a list of these passwords in their disk. 
This defeats the whole object. If you forget your network access password, the network administrator should 
be able to assign you with a new one. 

If you discover a virus on your computer don’t panic. If your virus checker alerts you to a virus, then the 
chances are that it has caught the virus before the virus could infect your computer and cause damage. For 
instance you may insert a disk into your computer and the virus checker should automatically scan the disk. If 
the disk contains a virus, a message will be displayed telling you that the disk is infected, and it should 
automatically remove the virus. The other common method of infection is via emails. 

If you work within a larger company, you should have a company IT support group 
that will come and rid your computer of viruses. Be sure that you are familiar with 
your company’s policy regarding viruses. 

Anti-virus software can only detect viruses (or types of viruses) that the software 
knows about. As such it is vital that you keep your Anti-virus software up to date so 
that it can detect new viruses that are constantly appearing. 
 
  
Malware 
The word Malware is a combination of the words "malicious" and "software".  Malware is software designed 
to install itself and run without your consent and without your knowledge.  Sometimes when you download 
free programs from an internet site, they come bundled with hidden programs that you did not ask for and 
will not want.  Often these hidden programs send back marketing information to companies.  Sometimes they 
may have more sinister purposes, such as sending your credit card details to criminals intending to steal from 
you. 

When installing free programs you find on the net always read the licensing terms, as often the malware 
content is hidden away within this long document. 
 
Spyware 
This is different from a virus.  Details such as your online browsing habits can be sent, without your knowledge, 
to marketing companies, or even criminal organizations that will try to get information such as your credit 
card details or access passwords. 
 
Worms 
A computer worm is a self-replicating computer program that sends copies of itself to other computers via a 
network.  It can copy itself from computer to computer without your knowledge. 
 
It is different from a virus because it has no need to hide itself within another program. Many worms can 
reduce your available bandwidth due to their copying activities, but otherwise do not actually damage your 
files.  However there are also destructive worms that will attack or compromise your data. 
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Trojans 
A Trojan horse (often just called a ‘Trojan’) is a type of software that you normally expect to do one thing, but 
in fact it does something else that you did not intend.  A Trojan is not a computer virus and does not try and 
copy itself across your network.  It is basically just a program that you need to run.  Sometimes you may run 
this Trojan program when you actually think you are running a legitimate program. The name comes from the 
classical story of the wooden Trojan horse. 
 
Scare ware 
These are popup messages that you may see displayed within a web browser, such as Internet Explorer, that 
falsely warn you that your computer is infected with a virus or spyware.  They invite you to you click on the 
popup link to solve the problem and then ask you to pay for software that will allegedly fix the problem.  In 
many cases the software that you then purchase is useless. 
 
NOTE: Do not confuse scare ware scams with legitimate popup messages from the virus checking program 
that is installed on your computer. 
 
Hardware 
The term hardware refers to the physical components of your computer such as the system unit, mouse, 
keyboard, monitor etc. 
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Parts of a computer 

You should understand some of the basic elements that make up a computer including:  
 
- Central processing unit (CPU). 
- Types of memory. 
- The hard disk. 
- Input and output devices. 
 
The CPU (Central Processing Unit) 
Normally an Intel chip (or equivalent) and it is one of the most important components within your computer. 
It determines how fast your computer will run and the CPU speed is measured by its GHz speed. Thus, a 4 GHz 
CPU is much faster than say a 1 GHz CPU. It is the CPU that performs all the calculations within the computer, 
when running programs such as word-processors, spread sheets and databases.   
 
The CPU contains the following elements:  
 
Control Unit:  
The control unit is responsible for controlling the sequencing and timing of the other elements making up the 
CPU. 
 
Arithmetic Logic Unit (ALU):  
The ALU performs the mathematical calculations using data stored within the CPU  
Registers:  
The registers are memory storage areas within the CPU that hold the data that is worked on by the ALU.  
BUS:  
The computer bus transports data between the memory and registers. 
 
More information: 
Intel: http://www.intel.com 
AMD: http://www.amd.com 
 
 
 
 
RAM (Random Access Memory 
Houses within your computer is where the operating system is loaded to, when you 
switch on your computer, and also where your applications are copied to when you 
start an application, such as a word processor or database program. When you create 
data, such as letters and pictures, these are initially created and held in RAM and then 
copied to disk when you save the data. As a rule of thumb, the more RAM you have 
installed in your computer the better. These days you will commonly find over 2 G Bytes 
of RAM installed. 
  
Disks 
You use disks to store any data that you create.  This can range from a memo created within a word processor 
to a video file created using a video camera.  There are many different types of disk.  Software is also supplied 
on disk, normally a CD or DVD disk. 
 
Hard disks are the main, large data storage areas within your computer. Hard disks are used to store your 
operating system, your application programs (i.e. your word processor, games etc.) and your data. They are 
much faster than CD or DVD disks and can also hold much more data.  Hard disks are installed within the 
system unit of your computer. 
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Input and Output ports 
Normally located at the back or on the side of your computer.  These include ports such as USB, serial, parallel, 
network and FireWire ports.  You plug cables into these ports to connect your computer to other devices, 
such as printers, scanners and cameras. 
 
The Universal Serial Bus 
You will see one or more USB sockets at the back of the system unit, allowing you to 
plug in devices designed for the USB. These devices include printers, scanners and 
digital cameras.  Memory sticks can also be plugged into a USB port allowing you to 
copy data to, or from, your hard disk. 
 
The Serial Port 
The serial port is a socket located at the back of your computer that enables you to 
connect items to the computer, such as a modem. They are commonly labelled as 
COM1 or COM2. 
 
The parallel port 
Is a socket located at the back of your computer that enables you to connect items to 
the computer, such as a printer.  Commonly labelled as LPT1 or LPT2. 
  
 
NOTE: The parallel port used to be the main way the computer connected to a printer.  
These days you are more likely to use a USB cable to connect the computer to a 

printer. 
 
The network port 
Allows you to plug a ‘network cable’ into your computer, which then lets you 
communicate with other computers connected to your local network or to other 
computers via the Internet. 
 
  
FireWire 
Is an interface from Apple Inc. that allows high speed data transfer between your 
computer and a compatible device such as a digital camera.  FireWire has largely 
replaced earlier ways of transferring data.  There are numerous 
versions of FireWire including fibre optic, coaxial and wireless versions.  
Most multimedia computers will have FireWire ports built into them.  
Fire wire connectors usually look like this: 
 
  
  



12 
 

What is software? 
 
The software is the collection of instructions that makes the computer work. For instance, when you type in 
words via the keyboard, the software is responsible for displaying the correct letters, in the correct place on 
the screen. Software is held either on your computer’s hard disk, CD, DVD or on a diskette (floppy disk) and is 
loaded (i.e. copied) from the disk into the computers RAM (Random Access Memory), as and when required. 
 

 
  

 
What is an operating system? 
 
The operating system is a special type of program that loads automatically when you 
start your computer. The operating system allows you to use the advanced features of 
a modern computer without having to learn all the details of how the hardware works. 
There are a number of different types of operating system in common use. The IBM PC 
(Personal Computer) was introduced way back in 1981 and was originally supplied with 
an operating system called DOS (Disk Operating System). This operating system was 
very basic, and you had to be a bit of a computer expert just to understand how to use 
it. It was NOT user-friendly. Later on, Microsoft introduced Windows and this is the 
operating system which is most widely used on PCs today.  To complicate matters 
further, there are a number of different types of Windows. Most people are today 
running either Windows XP, Windows Vista or Windows 7. 
 
UNIX and Linux are other examples of operating systems that may be run on PCs. 
 
Other types of computers, such as those manufactured by Apple have a completely different operating 
system. 
 
Microsoft Windows: Microsoft: http://www.microsoft.com 
IBM OS/2: http://www.ibm.com/software/os/warp 
Mac OS X: http://www.apple.com 
Linux: http://www.linux.org 
UNIX: http://www.unix.org 
 
Difference between the operating system and application programs  
The operating system works closely with the hardware that you have installed within your computer.  It 
interprets the input via the mouse or keyboard and outputs data to the screen. 
The application programs sit above the operating system, and make use of the functionality built into the 
operating system.  They are specific to a particular task.  For instance Microsoft Word is designed as a word 
processing program, while Microsoft Excel is a spread sheet program. 
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Examples of software applications  
An application program is the type of program that you use once the operating system has been loaded. 
Examples include word-processing programs (for producing letters, memos etc.), spread sheets (for doing 
accounts and working with numbers), databases (for organising large amounts of information), games 
programs and graphics programs (for producing pictures, advertisements, manuals etc.).  
It is important that you recognise examples of application programs covering the following areas: 
 
- Word processing 
- Spread sheets 
- Databases 
- Presentations 
- E-mailing 
- Web browsing 
- Photo editing 
- Computer games 
 
A word processing program (such as Microsoft Word) allows you to produce letters, memos, etc., easily. You 
can easily mail merge a list of names and addresses to produce mass mailers, individually addressed to 
customers or subscribers. 
 
A spread sheet program (such as Microsoft Excel) allows you to work out a company’s income, expenditure 
and then calculate the balance. It enables you to make 'what if' type projections of how the company will fair 
in the future and to forecast how changes in prices will affect profits. 
 
A database program (such as Microsoft Access) allows you to compile information and then to search this 
information to extract just the information you require. For instance, if you have a database of all the 
equipment housed within an office you can very simply produce a report listing only the equipment above a 
certain value. 
 
A presentation program (such as Microsoft PowerPoint) allows you to produce professional looking 
presentations that can be printed out directly onto slides for use with an overhead projector. Alternatively, 
you can display your presentations directly on a computer screen or via a computerised projector. 
 
There are many emailing programs available.  As the name suggests you use these to send and receive emails.  
Microsoft Outlook is supplied within Microsoft Office.  Another well know example is the Thunderbird email 
program. 
 
Applications used to view and interact with the World Wide Web (WWW).  
 
MS Internet Explorer:  http://www.microsoft.com 
Google Chrome:  http://www.google.com/chrome 
Firefox:  http://www.mozilla.org/products/firefox 
 
These programs allow you to edit digital photos.  You can adjust items such as the picture brightness, contrast 
and colour balance.  You can remove defects such the red eye effect often caused when using a flash.  You 
can apply interesting special effects and filters to visually enhance your photographs.  Examples include 
Photoshop from Adobe and Paint Shop Pro from Corel. 
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Computer Performance 

Factors affecting computer performance 
There are a wide range of factors that can affect the performance of your computer.  These include CPU 
speed, RAM size, type of graphics card, plus the number of applications running.  It is important to realise that 
it is not just the speed of the CPU that affect the overall performance of your computer.  There is no point in 
having a very fast CPU if the other parts of a computer may slow down the real world performance.   
 
CPU Clock speed 
The computer clock speed governs how fast the CPU will run. The higher the clock speed, the faster the 
computer will work for you. The clock speed is given in Gigahertz (GHz).  The higher the GHz speed the faster 
the computer. 
 
RAM size 
As a rule the more memory you have the faster the PC will appear to operate. Windows also uses the hard disk 
a lot, so logically the faster the hard disk can operate, the faster the PC will appear to run. 
 
Hard disk speed and storage 
Hard disks are also measured by their speed, defined by the disk access time, which is measured in 
milliseconds. The smaller this access time, the faster the hard disk will store, or retrieve data. The data storage 
capacity of hard disks continues to increase as new products are released. The disk storage capacity is 
measured in Gigabytes (G Bytes). 1 G Byte is equivalent to 1024 Mbytes. 
 
Free hard disk space 
To get the most out of your Windows based PC, you not only need a fast hard disk, but also a large hard disk, 
with plenty of "spare space". This is due to the fact that Windows is constantly moving data between the hard 
disk and RAM (Random Access Memory). Microsoft Windows will create many so-called “temporary files” 
that it uses for managing your programs. In fact, if you have very little free hard disk space, you may find that 
Microsoft Windows will not be able to run your programs at all. 
 
Error-Checking 
 This is a process of scanning the surface of the drive for any bad sectors. It detects and removes any broken 
part of cluster. It helps in increasing the life span of the Hard disk. 
Procedure; 

1. Open “Computer” 
2. Right-click desired drive e.g. C: then click “Properties” 
3. Click “Tools” then click “Error-Checking”. It will either do the process or schedule to run when you restart 

the computer. 
 
Disk Clean up 
Disk Clean up-Help in removing unnecessary files from the Hard drive. Follow this procedure; Open “Computer” 
icon on desktop and right-click a drive you want to clean, e.g. C: after right-clicking click ‘Properties” and 
under “General” tab click “Disk Clean up”. The computer will calculate the amount of disk space to be freed 
and will give you an option to remove. 
 
De-fragmenting files 
Disk Defragmentation help to arrange files in a better way so that it is easy for Operating Software to open it, 
hence improve computer performance.  
If you are running Windows you may find that if you click on the Start menu, select Programs, and then select 
the Accessories / System tools group, there is a de-fragmentation program. Running this periodically may 
noticeably speed up the operation of your PC. When you use a PC, over a period of time the files get broken 
up into separate pieces that are spread all over the hard disk. De-fragmentation means taking all the broken 
up pieces and joining them back together again. 
  
  



15 
 

Multitasking considerations 
Windows is a multitasking system, which means that it can run more than one program at a time. However 
the more programs that are running at the same time, the slower each one will run. To some extent this 
slowing effect depends on what each program is doing. Editing a large high definition video for instance can 
take up a lot of CPU time. 
 
CPU speeds 
The speed (operating frequency) of the CPU is measured in gigahertz (GHz).  The higher the value the faster 
the CPU will operate.  The original IBM PC released way back in 1981 ran at 4.77 MHz whereas modern PCs can 
run at over 4000 MHz, which gives you an idea of how far things have progressed. 
1 MHz means that the device will run at one million cycles per second.   
1 GHz is a thousand times faster, so that 1 GHz = 1000 MHz. 
 
Memory 
What is computer memory? 
You can store data on your hard disk, while data that is being processed is stored in RAM (Random Access 
Memory). Data that is stored on a hard disk can be permanent, while data in RAM is only temporary. Normally 
when people talk about memory in relation to a PC, they are talking about RAM. 
 
RAM 
Random Access Memory (RAM) is the main 'working' memory used by the computer. When the operating 
system loads from disk, when you first switch on the computer, it is copied into RAM. Commonly modern 
computers are supplied with over 2 G Bytes of RAM. As a rough rule, a Microsoft Windows based computer 
will operate faster, if you install more RAM. When adverts refer to a computer having 2 G Bytes of memory, it 
is this RAM which they are talking about. Data and programs stored in RAM are volatile (i.e. the information is 
lost when you switch off the computer). 
 
ROM 
Read Only Memory (ROM) as the name suggests is a special type of memory chip that holds software that can 
be read but not written to. A good example is the ROM-BIOS chip that contains read-only software. Often 
network cards and video cards also contain ROM chips. 
Data Storage 
 
Measurement of storage capacity 
It is important that you understand a little about the measurements used to define storage capacities:  
 
Bit:  
Computers are digital.  This means they work by processing ones and zeros.  The basic one or zero is called a 
bit of information. 
 
Byte:  
There are eight bits in a Byte. 
 
KB - Kilobyte:  
There are approximately a thousand bytes in a KB (also called a K Byte) 
 
MB - Megabyte:  
There are approximately a million bytes in a MB (also called a M Byte) 
 
GB - Gigabyte:  
There are approximately a thousand, million bytes in a GB (also called a G Byte) 
 
TB - Terabyte:  
There are approximately a million, million bytes in a TB (also called a T Byte). 
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Types of storage media 
There are a range of storage media to choose from including CDs, DVDs, USB flash drives, memory cards, 
internal hard disks, external hard disks, network drives and on-line file storage. Some are more suitable than 
others for a particular job, for instance a flash drive is great for quickly transferring relatively small amounts of 
data from one computer to another. 
Internal hard disks 
All PCs are supplied with an internal hard disk.  This is where the operating system (such as Windows) is stored.  
It is also were you store your data.  When you install new applications, they are copied from CD or DVD to your 
internal hard disk. 
  
External hard disks 
As the name suggests these are secondary hard disks that you can plug into 
your computer.  They are normally connected via a USB cable.  They are 
available in a range of speeds and storage capacities and are an ideal way to 
back up your data, such as photos or movies. 
 
CDs 
Most computers are now supplied with a CD drive. CD data discs look exactly 
like music CDs but contain computer data instead of music. The advantage of a CD is that it can hold a vast 
amount of data. The other big advantage of CDs is that they are interchangeable. This means that you can 
own a range of different CDs and choose which one to insert into your CD drive. 
 
DVDs 
Short for "Digital Versatile Disk”. Similar to CD drives but allows you to use DVD disks, which contain vastly 
more information than a traditional CD disk. These also transfer the data from the disk to the computer far 
faster, allowing you to watch movies on your computer screen. A CD disk can store 650 MB of data, while a 
DVD disk can store over 4 GB of data.  
 
USB memory sticks 
Flash drives plug into the USB port and when viewed via the Windows Explorer, 
look just like any other drive.  They are supplied in a range of sizes with the 1 GB 
devices being a very cheap way of transferring relatively small amounts of data 
between computers. 
 
  
 
Memory cards 
A memory card (also called a flash memory card) is a card containing memory chips that is often used in 
devices such as digital cameras, telephones, music players, video game consoles, GPS system and similar 
devices where there is a need to store data in a compact form, often using a battery power source.   There are 
a number of different types of memory cards with different 
storage capacities.   
 
Many new PCs have built-in slots for different types of memory 
cards. 
 
  
 
Network drives and on-line file storage 
Within an office it is normal that the computers are connected together via a network.  This allows you to 
store your data centrally, on a network server.  This network server should be backed-up by the IT support 
staff on a daily basis.  This means that your data is safely backed up for you. 
Alternatively you may create and store your data on your own PC or laptop and periodically copy it across the 
network to be stored safely on a central network server.  In many companies network software automatically 
backs up selected folders on each computer to the central server. 



17 
 

Floppy disks (diskettes) 
Floppy disks are also known as diskettes. They are very slow compared to 
hard disks, CD or DVD disks and hold relatively small amounts of data (1.44 
Mbytes). Sometimes people will backup (i.e. copy) important data from 
their hard disk to floppy disks. However, as diskettes are notoriously 
unreliable this is not the best way of backing up valuable data (but is better 
than nothing).  Modern computers are not normally supplied with this type 
of drive.  Floppy disks have almost entirely been replaced by CD or DVD 
disks. 
 
Input and Output Devices 
What are input devices? 
Input devices allow you to input information to the computer and include things such as the keyboard and 
mouse. 
 
Keyboard 
The keyboard allows you to type information into the computer. It has evolved 
over the years.  The keyboard is built into laptop computers but is a separate 
item if used with a Desktop computer.  They can be connected via cables or may 
be wireless. 
 
  
 
Mouse 
When using an operating system, such as Microsoft Windows, you use the mouse to 
select drop down menus, to point and click on items, to select items and to drag and 
drop items from one place to another. 
   
 
 
What are output devices? 
Includes items such as screens (monitors), printers, speakers and headphones. 
 
 
Traditional computer monitor 
An output device. The original computer monitors were TV type screens on which 
you viewed your programs. They were supplied in different sizes, common sizes 
range from 15" to 21" screens. You should be aware that poor quality or badly 
maintained monitors could harm your eyesight. 
 
  
Flat screen computer screens 
Traditional computer monitors are based on the same sort of technology that is 
used within a television screen. 
 
More recently, flat screen computer screens have become available. These take up 
a lot less room on a desk and use less energy than the traditional, more bulky 
monitors. 
 
You should be aware that often if you specify a screen of a certain size, say a 17-
inch screen, this is the size measured diagonally, not horizontally across the screen. 
If you are upgrading you should also ask for the "visible viewing area" of the screen. 
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Printers 
Most data is printed once you have created it and there are a vast number of different printers available to 
accomplish this. Most common are ink jet and laser printers both of which can now produce coloured output 
(at a cost). 

      
Different types of printer 
There are many different types of printers. In large organisations, laser printers are most commonly used 
because they can print very fast and give a very high quality output. In most organisations, the printers are 
connected to the computers via a network. This means that each person with a computer does not require his 
or her own printer. Each computer connected to the network can print using a particular shared printer. 
When you buy a printer, one of the things the salesperson will not necessarily stress is how much it will cost to 
keep that printer running.  Laser printers do not use ink; they use something called toner that is normally 
supplied in a sealed unit called a toner cartridge. Each toner cartridge will allow you to print a certain amount 
of pages and when the toner is used up it needs to be replaced. In some cases the costs of these toner 
cartridges is very high. Ink jet printers can work out even more expensive to run. 
 
Laser printers 
Laser printers produce high print quality at high speed. They are called "laser printers" due to the fact that 
they contain a small laser within them. There is a wide range of laser printer manufacturers and one buzzword 
to be aware of is Postscript, a type of printer that is designed to give very high quality reproduction of 
pictures. 
 
Colour laser printers 
Originally, most laser printers would only print in black and white (mono). More recently colour laser printers 
have dropped in price and are entering wide spread use. While many of these produce excellent results, you 
should be aware of the fact that the "price per page", especially if you are using a lot of colour on a page can 
be very high compared to the cost of printing in black and white. 
 

 
  
Inkjet printers 
Inkjet printers work by using tiny jets to spray ink onto the paper. Inkjet printers are very quiet in operation 
and produce print quality comparable to that of laser printers, though laser printers still have the edge in 
terms of speed. Inkjet printers are ideal for low volume printing where high quality print is required and speed 
is not a high priority, e.g. printing letters in a small office or in the home. 
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Using Excel 2010 
 
Starting the Excel program Excel 2010 

 
Click on the Start button (bottom-left of the screen). Click on All Programs. Click on Microsoft Office.  Click on 
Microsoft Excel 2010.  The Excel window will be displayed, as illustrated. 
 

  
 

What is the Active Cell? 
Excel identifies the active cell with a bold outline around the cell and highlighting the column heading letter 
and row heading number of the cell.  In the following example, B2 is the active cell: 
 

 
  
 
In the above illustration, notice that B2 is displayed in the Name Box and the contents of the cell is displayed 
in the Formula Bar.  In this case, 2002 is a calculated value, 2000+2. 
In order for you to enter data into a cell, it needs to be the active cell.  The active cell will accept keyboard 
entries.  You can make a cell active by clicking on it or navigating to it. 
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The Excel cell referencing system 
 
An Excel worksheet is made up of individual cells, each of which has a unique reference.  Look at the 
illustration below.  We have clicked on cell B3, which means that the cell is in column B, row 3. 
 

  
 
In the illustration below, we have clicked on cell D2. 
 

 
  
 
If you look carefully you will see that the current cell reference is displayed just above the actual worksheet. 
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Entering numbers and text 
 
Click on cell B2, as illustrated. 
 
  
 
 
 
 
 
 
 
 
 
 
Type in the word 'Region'.  Press the Enter key.  When you press 
the Enter key you will automatically drop down to the next cell 
within the worksheet.  Your screen will now look like this. 
 
 
 
 
 
 
 
 
 
 
The active cell is now B3.  Type in the word 'North'.  Press the 
Enter key. 
The active cell is now B4.  Type in the word 'South'.  Press the 
Enter key. 
The active cell is now B5.  Type in the word 'East'.  Press the Enter 
key. 
The active cell is now B6.  Type in the word 'West'.  Press the 
Enter key. 
 
Your screen will now look like this: 
 
  
 
 
Click on cell C2.  Type in the word 'Sales'.  Press the Enter key. 
Type in the number 10488 and press the Enter key. 
Type in the number 11973 and press the Enter key. 
Type in the number 13841 and press the Enter key. 
Type in the number 16284 and press the Enter key. 
 
Your screen will now look like this: 
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Default text and number alignment 

If you look carefully at what you have typed in you will see that by default text is aligned within a cell to the 
left, while numbers are aligned within the cell to the right.  This makes sense, as normally text starts from the 
left of a page and it is the same within a cell.  Numbers on the other hand normally align to the right.  Think 
how you would write down a column of numbers on a page that you want to add up.  Numbers align to the 
right. 
 

Summing a column of numbers 
 
Click on cell B7 and type in the word 'Total'. 
Click on cell C7. Click on the Formulas tab, and 
then click on the AutoSum button. 
 
  
Your screen will look like this: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press the Enter key and Excel will automatically add up the 

column of numbers, as illustrated. 
 
  
We have hardly started to use Excel but already you have 
seen how powerful and easy to use it is.  We will see more of 
the Excel functions for performing calculations later. 
 
 
 
 
 
 
 
 
 
 
 
 
The best thing about Excel is that if you make changes to the numbers then totals and other calculations are 
automatically updated.  Click on cell C4 and type in a different number.  When you press the Enter key you will 
see that the total value displayed in cell C7 changes to recalculate the total value of the sales. 
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Entering a date 
 
Click on cell A1.  Enter the following information and then press the Enter key. 
 
“2/2/2010” 
 

  
 
Excel recognises this as a date and automatically marks the cell as containing date information. 
 
Right click over the date you have just entered.  From the popup menu displayed, select the Format Cells 
command, as illustrated. 
 

  
 
Excel recognises this as a date and automatically marks the cell as containing date information. 
 
Right click over the date you have just 
entered.  From the popup menu displayed, 
select the Format Cells command, as 
illustrated. 
 
This will display the Format Cells dialog box. 
 
  
 
If you have time you can select a different 
type of date format, using the Type section 
of the dialog box.  Click on the OK button to 
apply any changes you make. 
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Worksheets and Workbooks 
 
Look at the bottom-left of your screen and 
you will see the worksheet tabs displayed. 
 
 
  
By default each workbook contains three worksheets.  This is similar to a Notebook that contains separate 
pages.  Click on the Sheet 2 worksheet tab and the second worksheet is displayed.  Click on the Sheet 3 
worksheet tab and the third worksheet is displayed.  Click on the Sheet 1 worksheet tab and the first 
worksheet, containing your data is displayed again.  As we will see later you can add or remove worksheets as 
well as reordering and renaming them. 
 

Saving a workbook 
 
To save the workbook click on the Save icon (top-left part of your screen). 
  
This will display the Save As dialog box. 

 
  
Navigate to the folder containing your sample files.  To do this, double click on the Excel 2010 Basics folder. 
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You will see the sample files listed within the Excel 2010 Basics folder. 
 

 
  
 
Click within the File name section of the dialog box to name the file.  In this case use the file name My First 
Workbook. 
 

  
 
 
Click on the Save button to save the file to disk. 
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Closing a workbook and exiting the Excel program 
 
To close the workbook, click on the File Tab (top-left of your screen), from the drop down options displayed, 
click on the Close command. 
 

 
  
 
The screen will now look like the illustration below.  The Excel program is open but no workbook is displayed 
within the program. 
 

  
 
To close the Excel program, click on the Close icon.  This icon is the small cross displayed at the top right of the 
Excel screen. 
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Creating a new workbook 
 
Start the Excel program. Each time you start the Excel program, by default, it displays a new blank workbook 
containing three blank worksheets.   Type in your First Name in to cell A1 and press the Enter key. 
To create a new workbook, press Ctrl+N.  This is the keyboard shortcut for creating a new file. A new 
workbook will be created containing three worksheets.  Type in your Second Name in to cell A1.   
Close both workbooks without saving your changes. 
 

Opening a workbook 
 
Press Ctrl+O which is the keyboard shortcut to open an existing file. 
 
Or click on the File Tab (top-left) and then click on the Open command. 
 

 
  
This will display the Open dialog box.  Navigate to the folder called Excel 2010 Basics, (under the Documents 
folder), containing your sample files.  
Select a file called Sales 2005, and then click on the Open button to open the workbook.   
Open the workbook called Sales 2006 and also a workbook called Sales 2007.  You now have three open 
workbooks. 
 

Switching between workbooks 
 
To switch to a particular Excel workbook, click on the Excel workbook icon displayed within the Windows 
Taskbar (across the bottom of the screen).  From the popup list displayed select the required wordbook. 
 

  
 
TIP: You can use the Alt+Tab keyboard shortcut to switch between open programs. 
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Saving a workbook using another name 

Open the workbook called Sales 2005.  Click on the File Tab and then select the Save As command.   
 

 
  
 
The Save As dialog box will be displayed. 
 

  
 
In the File name section enter a new file name, in this case called My Backup.  Click on the Save button.  You 
now have two copies of the same file, both containing the same information.  This can be useful for making 
backups of your data or for retaining copies of a workbook with different versions of the data in each file. 
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Saving a workbook using a different file type 
 
Click on the File Tab and then select the Save As command.   
 
  
 
 
 
 
 
 
 
 
 
 
The Save As dialog is displayed.  Click on the down arrow within the Save as type section of the dialog box.   
 

  
 
You can select the required file type from the drop down displayed. 
  

 
 
TIP: If you want to email a copy of an Excel 2010 workbook to someone that has an earlier version of Excel, 
such as Excel 2003, then you may need to save the file in the Excel 97-2003 Workbook file format. 
 
Alternatively, people with earlier versions of Excel can download additional free software from Microsoft 
allowing them to open and view (but not necessary edit), files created using Excel 2010. 
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Other commonly used file type options include:  
 
Text file:  
Saving your worksheet as a plain text file will remove all the formatting you have added to your worksheet 
(such as bold, italics & underlining).  It will also remove any pictures or other features such as tables.  Only 
plain text will be saved.  Be very careful about using this option. 
 

  
 
Template:  
You normally save a workbook as a workbook file.  You can however save a workbook as a template.  This 
means that you can create new workbooks in the future; based on the templates you create. 
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CSV file:  
This saves table data in a form that can be used by other programs.  It is short for Comma Separated Value. 
 

  
 
Close any open dialog boxes and close all open worksheets. 
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Getting help within Excel 2010 

 
Click on the Microsoft Excel Help icon (towards the top-right of the 
screen). 
 
TIP: Or press the F1 help key. 
 

The Excel Help window is displayed. 
 
  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you can see a wide range of help topics are displayed.   
Click on the Getting Started with Excel 2010 link.  This will 
display the following information. 
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Click on the What's new in Excel 2010? link.  You will see 
the following. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Improved Ribbon link.  You will see the following. 

 
  
 
 
 
 
 
 
 
 
 
TIP: Click on the Maximise 
button within the top-right 
part of the dialog box.  This 
will make the dialog box fill 
the screen and the 
information within it will be 
easier to read. 
 
 
 
Spend a little time browsing 
what's new within this 
version of Excel.   
When you have finished 
experimenting, close the 
Excel Help window. 
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Searching for Help 
 
You can search for help on a topic of particular interest. Press F1 to display the Excel Help window.  Within the 
text box near the top of the Excel Help window, type in a word or words relating to the help you need.  For 
instance, to display help about printing, type in the word 'printing'. 
 

 
  
 
Click on the Search button next to the text input box.   
 

 
 
  
You will see a range of topics related to printing.  Clicking on any of these topics will display more information 
about printing. 
 

  
 
Close the Excel Help window when you have finished experimenting. 
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The Help 'Table of Contents' 
 
Press F1 to display the Excel Help window. Click on the Table of Contents icon (the book icon displayed within 
the Excel Help window toolbar). 
 

  
 
You will now see a Table of Contents displayed down the left side of the Excel Help window. 
 

  
 
Take a little time learning to navigate through this table of contents. 
 
 

Printing a Help topic 
 
Display an item of interest within the Excel Help window.  Click on the Print icon displayed within the Excel 
Help toolbar. 
 

  
 
Close all open dialog boxes before continuing. 
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Alt key help 
 
Press CTRL+N to open a new blank workbook 
Click on the Home tab. 
Press the Alt key and you will see numbers and letters displayed over icons, tabs or commands, towards the 
top of your screen.   
 

 
  
If you type in a number or letter you will activate a command.  For instance in the example shown,  
the number 1 is displayed over the Save icon.  Type in 1 and you will see the Save As dialog box 
displayed.  Close this dialog box.   
Press the Alt key again and you will see an N displayed over the Insert tab.  Press N and you will see 
the contents of the Insert tab displayed. 
This is a very easy way of learning keyboard shortcuts.  You now know that Alt+1 will display the 
Save As dialog box and that Alt+N will display the Insert Tab. 
Click on the Home tab before continuing. 
 

Selection techniques 
 
Why are selection techniques important? 
Often when you want to do something within Excel you need to select an item first.  This could involve 
selecting a cell or multiple cells.  It may need you to select a row, a column or even the entire table. 
 

Selecting a cell 
 
Open a workbook called Selection techniques.  To select a cell simply click on that cell.  Thus to select cell B3, 
click on cell B3. 
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Selecting a range of connecting cells 
 
We want to select the cells 
from C3 to G3.  To do this click 
on the first cell within the 
range, i.e. C3.  Then press 
down the Shift key (and keep 
it held down).  Click on cell G3.  
When you release the Shift 
key the cell range will remain 
selected, as illustrated. 
 

 
  
 
 
 

Selecting a range of non-connecting cells 
 
Sometimes we need to select multiple cells that are not next to each other, as in the example below, where 
C3, E3 and G3 have been selected. 
 

  
 
To do this click on the first cell, i.e. C3.  Then while keeping the Ctrl key pressed click on the cells E3 and G3.  
When you release the Ctrl key the cells will remain selected. 
 
 

Selecting the entire worksheet 
 
To select the entire worksheet, click on the intersection between the column and row referencing numbers. 
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Selecting a row 
 
To select a row, say the row relating to Canada, click on the relevant row number displayed down the left side 
of the worksheet. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The selected row will look like this. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selecting a range of connecting rows 
 
To select the rows relating to Canada, USA, UK and Australia. First click on the row number next to Canada (i.e. 
5).  Press down the Shift key and keep it pressed.  Click on the row number relating to Australia (i.e. 8).   
When you release the Shift key the multiple rows remain selected. 
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Selecting a range of non-connected rows 
 
Click on the row number 3 and press down the Ctrl key.  Click on row number 5, then row number 7 and finally 
number 9.  Release the Ctrl key and the rows will remain selected. 
 

  
 

Selecting a column 
 
To select the column containing data relating to 2003, click on 
the column header C, as illustrated. 
 

  
 
 
 
 
 
 
 
 
 
 
 
The selected column will look like this. 
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Selecting a range of connecting columns 
 
To select the columns relating to the sales 
figures for 2003-2006, first select column C.  
Press the Shift key and while keeping it 
pressed select column F. When you release 
the Shift key the columns will remain 
selected. 
 

 
  
 
 
 
 
 
 

Selecting a range of non-connecting columns 
 
To select the columns relating to 2003, 2005 and 2007, first select the column C.  Press the Ctrl key and keep it 
pressed.  Select column E and then select column G. Release the Ctrl key and the columns remain selected. 
 

  
 
Close the workbook without saving any changes you may have made. 
 
 

Recommended techniques when creating or editing lists  
Each cell should contain the smallest data element.  For instance if you are storing a person’s name, use one 
cell for the first name and another cell for the second name.  This means that at a later date you could 
manipulate the data to sort by the second name.  For the same reason split the details of an address into as 
many smaller parts as possible so that later you could search by state/region , by post code/zip code or even 
by country if you are maintaining an international list. 
The top row of your data will often contain the headers of each column.  These are called field names. 
A list should not contain blank rows or columns within the data.  This can cause problems when later sorting 
your data. 
Ensure that cells bordering your list are blank. 
If your data has a bottom row which contains totals, it is often a good idea to insert a blank line above the row 
of totals. 
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 Manipulating  

 

Manipulating rows and columns 
 
Inserting rows into a worksheet 
 
Open a workbook called Rows and columns.  
We need to insert a row for Japan between 
the row for Canada and the row for the USA.  
Select the row for the USA, as illustrated. 
 

 
  
 
 
 
 
 
 
Right click over the selected row and from the popup 
menu displayed select the Insert command. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The table will now look like this. 
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Click on cell B6 and type in the word 'Japan'.  Enter the following sales figures for Japan. 

  
 
 

Inserting columns into a worksheet 
 
We want to insert a column for sales figures in 2002, which needs to be inserted before the 2003 column. 
Select the column relating to 2003, as illustrated. 
 

  
 
 
Right click over the selected column and from the popup menu displayed select the Insert command.   
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The column will be inserted, as illustrated. 
 

 
  
Enter the following data into the column. 
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Deleting rows and columns 
 
Deleting rows within a worksheet 
 
Select the row relating to Canada. Right click over the selected row and from the popup menu displayed 
select the Delete command. 
 

  
 
The row is deleted without any additional warning. 
 
TIP: To delete multiple connected rows, use the Shift key trick to select multiple rows and then right click to 
delete the rows.  To delete multiple non-connected rows, use the Ctrl key trick to select the multiple rows and 
then right click to delete the rows. 
 

Deleting columns within a worksheet 
 
Select the column relating to Sales 2007. Right click over the selected column and from the popup menu 
displayed select the Delete command.   
 

 
  
The column is deleted without any additional warning. 
 
TIP: To delete multiple connected columns, use the Shift key trick to select multiple columns and then right 
click to delete the columns.  To delete multiple non-connected columns, use the Ctrl key trick to select the 
multiple columns and then right click to delete the columns. 
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Modifying  
 
Modifying column widths 
 
Select a column, such as the Sales 2004 column. Right click over the selected column and from the popup 
menu displayed select the Column Width command. 
 

  
 
The Column Width dialog box is displayed which allows you to set the column width.  Click on the Cancel 
button to close the dialog box. 
 

  
 
 
Modifying column widths using 'drag and drop' 
 
Move the mouse pointer to the line between the header for column B and column C, as illustrated below. 
 

  
 
Press the mouse button and keep it pressed.   
 
The pointer changes to a black cross with double arrows when placed on the line between two columns. 
 
Move the mouse pointer left or right to make the column narrower or wider.  Release the mouse button and 
the column width will change as required. 
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Automatically resizing the column width to fit contents 

Resize all the columns so that they are too narrow to 
properly display the data contained within the columns.  
Your screen will look similar to the illustration below. 
 

 
 
 
 
 
 
 
 

  
To automatically resize each column width to fit the 
contents, select all the columns containing data.   
 

  
 
 
 
 
 
 
 
 
 
 

 
Double click on the junction between one of the column 
headers within the selected columns. 
 

  
 
 
 
The columns will automatically resize to accommodate the data within each column. 
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Modifying row heights 
 
Select one or more rows and then right click over the selected row(s).  From the popup menu displayed select 
the Row Height command. 
 

  
 
The Row Height dialog is displayed allowing you to set the exact row height, as required. 
 

 
  
 
TIP: If you click between any two row headers, you can drag the row height up or down as required, to modify 
the row height. 
 
Save your changes and close the workbook.  
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Manipulating cells and cell content  
 

Copying a cell or range contents within a workbook 
 
Open a workbook called 
Copying moving and deleting. 
Select a cell, range, row or 
column to copy.  In this case 
select the range B4 to E4. 
 
TIP: A range like this is often 
written as B4:E4. 
 
Your screen will look 
something like this: 
 
Press Ctrl+C to copy the 
selected range to the 
Clipboard. 
 
TIP: To copy a selected item to the Clipboard using the Ribbon, 
click on the Home tab and then click on the Copy icon in the 
Clipboard group on the Ribbon. 
 

  
 
 
Click at the location you wish to paste the data to.  In this case click on cell B14 and 
press the Ctrl+V keys to paste the data from the Clipboard. 
 
TIP: To paste an item from the Clipboard using the Ribbon, click on the Home tab 
and then click on the Paste icon, in the Clipboard group on the Ribbon. 
 
 
Your data will now look like this. 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
TIP: You can use the same technique to copy entire rows or columns.  Pressing Ctrl+A will select everything 
within a worksheet and allow you to copy the entire worksheet contents to the Clipboard when you press 
Ctrl+C. 
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Deleting cell contents 
 
Select the range that you wish to delete the 
contents of.  In this case select the range 
B10:E10, as illustrated. 
 
Press the Del key and the cell contents will 
be deleted. 
 
TIP: You can use the same technique to 
delete entire rows or column contents. 
 
Pressing Ctrl+A will select everything within 
a worksheet and allow you to delete the 
entire worksheet contents when you press 
the Del key. 
 

Moving the contents of a cell or range within a workbook 
 
Select the range you wish to move and 
then cut it to the Clipboard.  In this case 
select the data, as illustrated. 
 
Press the Ctrl+X keys to cut the selected 
data to the Clipboard. 
Click at the location you wish to move 
the selected data to, in this case click in 
cell B15, and press Ctrl+V, to paste the 
data. 
 
TIP: You can use the same technique to 
move entire rows or columns. 
 
Save your changes and close the 
workbook. 
 

Editing cell content 
 
It is easy to edit existing data within a cell or to replace existing data within a cell. Open a workbook called 
Editing. 
Click on cell B3.  Double click in front of the word 'Region' and insert the word 'Sales' followed by a space.  
Press the Enter key to commit your changes to the cell. 
Click on cell B7.  Double click on the word 'West', to select it and then over type the selected word with the 
word 'Central'.  Press the Enter key to commit your changes to the cell. 
 

Undo and Redo 
 
Click on the Undo icon (top-left of your screen) to reverse the last action.  
Try it now. 
 
Click on the Redo icon (top-left of your screen) to reapply the last action.  
Try it now. 
 
Save your changes and close the workbook. 
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Copying data between worksheets (within the same workbook) 

Open a workbook called Worksheet manipulation. 
Select a cell, range, row or column to copy.  In this case select the range B3:C8.  Your screen will look 
something like this: 
 

  
 
Press Ctrl+C to copy the selected range to the Clipboard.  Click on the second worksheet tab (called 
Projections). 
 

 
 
 You will now see the contents of the second, empty worksheet displayed. 
 
Click at the location you wish to paste the data to.  In this case click on cell C4 and press the Ctrl+V keys to 
paste the data from the Clipboard.  You have successfully copied selected data from one worksheet to 
another worksheet within the same workbook. 
 
BEFORE CONTINUING:  Click on the Undo icon to undo this copy. 
 
The Undo icon is displayed towards the top-left of your screen. 
 
Leave the workbook open and carry on to the next section. 
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Moving data between worksheets 

Moving data between worksheets (within the same workbook) 
 
Switch back to the first worksheet within the workbook called Worksheet manipulation. 
Select a cell, range, row or column to move.  In this case select the range B3:C8.  Your screen will look 
something like this: 
 

 
  
Press Ctrl+X to cut (move) the selected range to the Clipboard. 
Click on the second worksheet tab (called Projections). 
 

  
 
You will now see the contents of the second, empty worksheet displayed. 
 
Click at the location you wish to paste the data to.  In this case click on cell C4 and press the Ctrl+V keys to 
paste the data from the Clipboard.  You have successfully moved selected data from one worksheet to 
another worksheet within the same workbook. 
 
Save your changes and close the workbook. 
 
Moving data worksheets (in different workbooks) 
Open a workbook called Between workbooks 1. 
Open a second workbook called Between workbooks 2. 
Display the contents of the Between workbooks 1 workbook. 
 
NOTE: To switch between multiple open workbooks, click on the Excel icon displayed within the Taskbar at 
the bottom of the screen and click on Between Workbooks 1. 
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 Within the Between workbooks 1 workbook, select a cell, range, 
row or column to move.  In this case select the range B3:C8.  
Your screen will look something like this: 
 
Press Ctrl+X to cut (move) the selected range to the Clipboard. 
 
Switch to the second workbook (called Between workbooks 2). 
Click at the location you wish to paste the data to.  In this case 
click on cell C4 and press the Ctrl+V keys to paste the data from 
the Clipboard.  You have successfully moved selected data from 
one workbook to another workbook. 
 
NOTE: You could have selected a different worksheet within the 
second workbook if you wanted. 
 
Copying data between worksheets (in different workbooks) 
Select the data in the second workbook. 
Press Ctrl+C to copy the selected data to the Clipboard. 
Switch back to the first workbook. 
Click where you wish to paste the data to. 
Press Ctrl+V to paste the data from the Clipboard. 

 
You have now copied selected data from one workbook to another workbook. 
 

 
Auto Fill 
 
Open a workbook called AutoFill. 
Click on cell B3 which contains the word Monday.  
 
 
 
 
 
 
 
 
 
 
 
 
Move the mouse pointer to the bottom-right corner of this cell and the 
mouse pointer shape will change to the shape of a small black cross.  
When the mouse pointer changes shape, press the mouse button down, 
and while keeping it pressed move slowly down the page to cell B7.  
When you release the mouse button you will see that Excel has 'Auto 
Filled' the range you dragged across with days of the week. 
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Click on cell C3 which contains the word January.   
 

  
 
 
 
 
 
 
Use the AutoFill feature to automatically create a column 
containing all the months of the year. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the cell range D3:D4.   
 

 
 
 
 
 
 
Use AutoFill to extend the series down the page.  As you will 
see the series becomes 1,2,3,4,5,6,7 etc. 
 

  
 
 
 
 
 
 
 
 
 
 
 
Select the cell range E3:E4.   
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Use AutoFill to extend the series down the page.  As you will see the series becomes 2,4,6,8,10 etc. 
 

  
 
Save your changes and close the workbook. 
 

 
Renaming a worksheet 
 
Click on the Sheet1 tab to display the first worksheet. Double click on the Sheet1 tab. 
 

  
 
The worksheet tab will be highlighted and you will be able to type in a new name.   
 

  
 
In this case type in the name 2008 and then press the Enter key to confirm the change, as illustrated. 
 

  
 
Double click on the Sheet2 tab and rename it 2009. 
Double click on the Sheet3 tab and rename it 2010.  Your tabs will now look like this: 
 

  
 
By default worksheets are called Sheet1, Sheet2 and Sheet3.  You should use meaningful names for your 
worksheets, especially if you are using multiple worksheets within a workbook.  This can make a complicated 
workbook much easier to understand. 
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Inserting a new worksheet 
 
Click on the 2010 worksheet tab to select it.  Right click over the tab and from the popup menu displayed, click 
on the Insert command. 
 

 
 
  
The Insert dialog is displayed.  Make sure that the Worksheet object is selected within the dialog box. 
  

 
 

Then Click Ok button to insert a New worksheet 
 
 

Deleting a worksheet 
 
Make sure that the new tab that you have just inserted is selected.  Right click on the tab and from the popup 
menu displayed select the Delete command.  The new worksheet will be deleted. 
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Formatting 

Font formatting 
 
Font formatting options 
The font formatting options are located on the 
Home tab within the Font group. 
 

 
Font type 
 
Open a workbook called Font formatting. Select 
the range C3:G3.   
 

  
 
 
 
 
 
 
 
 
Under the Home tab, click on the down arrow 
next to the Font section. 
 

  
 
 
 
From the drop down list displayed, select a 
different font type, such as Arial. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Experiment with applying different fonts to your data. 
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Font size 
 
Select the range B3:B12.  Click on the down arrow within the Font Size section and select a different font size. 
 

  
 
TIP: You can also select a range and use the Increase Font Size and Decrease Font Size icons. 
 

  
 
Bold, italic, underline formatting 
 
Select the range C4:G12 and experiment with applying bold, italic and underline formatting using the icons 
illustrated below. 
 

  
 
 
TIP: You can easily apply double underline formatting.  To do this click on the down arrow next to the 
Underline icon.  Select the Double Underline command. 
 
 
  



58 
 

Cell border formatting 
 
Select the range B3:G12.  Click on the down arrow next to 
the Border icon.   
 

  
 
A drop down list is displayed from which you can select the required border.  Select All Borders. 
 

 
  
Your data will now look like this.   
 

  
 
Click on the Undo icon (top-left of your screen) to undo this formatting. 
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Spend a little time experimenting with applying different types of borders.  Remember that you can use the 
Undo icon to undo any formatting that you apply. 
 
 
TIP: Experiment with applying border formatting effects, such a thick or double edged border effects. 
Formatting the background colour 
Select the range B3:G3. Click on the down arrow next to the 
Fill Colour icon.  
 

 
  
 
 
Move the mouse over a colour and 
you will see the colour formatting 
previewed within your data.  Click on 
a colour to apply it. 
 

  
 
TIP: Be careful when applying 
background fill colours as it may 
make any text within the range 
difficult to see.  Avoid using similar 
text colours and background fill 
colours. 
 
 
 
 

Formatting the font colour 
Select the range B3:B12. Click on the down arrow next to the 
Font Colour icon.   
 

  
 
 
 
 
This will display a drop down from 
which you can select the required 
colour.  Experiment with applying 
different font colours. 
 

 
  
 
 
 
 
 
 
 
 
Save your changes and close the workbook. 
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Alignment formatting 
 
The alignment options are contained within the Alignment 
group on the Home tab. 
 

  
 

Horizontally aligning contents in a cell range 
 
Open a workbook called 
Alignment. Select the range 
C3:G12. Click on the Centre icon 
to centre the cell contents in 
this range.  Try applying left 
and then right alignment 
formatting.  Use the alignment 
icons illustrated below. 
 
Centring a title over a cell range 
 
Click on cell C2 and type 
in the word 'Sales'.   
 

  
 
 
 
 
 
 
We want to centre this 
within the range C2:G2.  
To do this, select the 
range C2:G2. 
 

  
 
Click on the Merge and Centre 
icon. 
  

 
 
 
 
Your screen will now look like this. 
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Cell orientation 
 
Select the range C3:G3.   
  

 
 
Click on the Orientation icon.   
  

 
 
You will see a drop down menu allowing you to format the cell orientation. 
  

 
 
Select the Angle Clockwise command.  Your data will now look like this. 
 

  
 
Experiment with applying some of the other orientation effects. 
 
Save your changes and close the workbook. 
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Number formatting 
 
Open a workbook called Number formatting. Click on cell C2.   
 

  
 
 
Click on the down arrow next to the Number Format control.   
 

  
 
 
 
 
You will see a drop down menu from which you can select the format.  In this case select Number. 
 

  
 
This tells Excel that the data contained within this cell should always now be treated as a number, rather than 
say text or a date. 
 



63 
 

Decimal point display 
 
Click on cell C4.   
 

  
 
 
Click on the Decrease Decimal icon a few times, so that no decimal places are displayed. 
 

  
 
The cell contents should now look like this. 
 

  
 
Set the contents of cell C5 to display 1 decimal point. 
 

  
 
Set the contents of cell C6 to display 2 decimal points. 
 

  
 
 
TIP: To increase the number of decimal points displayed, click on the Increase Decimal icon. 
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Applying and removing comma style formatting (to indicate thousands) 
 
Click on cell C8.   
 

  
 
 
Click on the Comma Style icon (within the Number group under the Home tab) to format the number using 
commas. 
 

  
 
Your number should now look like this. 
 

  
 
NOTE: To remove comma style formatting, click on the down arrow next to the Number format icon (within 
the Number section of the Home tab). 
 

  
 
Select the General or Number format option, as illustrated. 
 

  
 
The cell contents will now be displayed without comma style formatting. 
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Currency symbol 
 
Select cell C10. 
 

  
 
Format it to display the British Pound symbol.  To do this click on the down arrow next to the Currency icon. 
 

  
 
  
From the list displayed, select the £ option. 
 

  
 
Select cell C11 and format it to display the Dollar symbol. 
Select cell C12 and format it to display the Euro symbol. Your data will now look like this. 
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Date styles 
 
Click on cell B17 and type in the text 'The date today is'.   
Click on cell C17 and type in today's date.  When you press the Enter key you may find that the style of the date 
changes automatically. 
Right click over cell C17 and from the popup menu displayed select the Format Cells command. 
 

  
 
  
This will display the Format Cells dialog box. 
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If necessary, within the Category section of the dialog box, select the Date category. 
 

  
 
Select the required format from the Type section of the dialog box. 
 

  
 
Click on the OK button to apply the date format.  Experiment with applying different types of date format to 
the cell.  
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Formulas 

 

Creating formulas 
 
Open a workbook called Formulas. Click on cell E3.   
 
In cell E3 we need to create a formula that will calculate the value of the stock for that particular component.  
To do this we need to multiply the contents of cell C3 by the content of cell D3. 
 
All formulas within Excel start with the 'equals' symbol.   
 
Type in the following formula. 
 
=C3*D3 
 
TIP: the * symbol means 'times'. 
 
Press the Enter key and you will see the result of the calculation in cell E3. 
 
Click on cell E3 and you will see the formula displayed in the bar above the worksheet. 
 

  
 
 
The easy way to create formulas 
 
Click on cell E4 and type in the equals sign. 
 

  
 
Click on cell C4 and you see this. 
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Type in the * symbol, you see this. 
 

  
 
Click on cell D4 and you will see this. 
 

  
 
Press the Enter key and you see the result of the calculation.  This method may seem more complicated at 
first but when you are creating complex formulas, you will find this method is actually easier and helps to 
reduce errors, such as typing incorrect cell references. 
 
 
Using operators in formulas 
 
Open a workbook called Formula operators. 
 
Click on cell C3 and enter the following which will add the number 3 and 7: 
=3+7 
 
Press the Enter key and you will see the result displayed in the cell. 
 
Click on cell C4 and enter the following which will subtract the number 4 from the number 18: 
=18-4 
 
Press the Enter key and you will see the result displayed in the cell. 
 
Click on cell C5 and enter the following which will divide the number 20 by the number 4: 
=20/4 
 
Press the Enter key and you will see the result displayed in the cell. 
 
Click on cell C6 and enter the following which will multiply the number 4 by the number 9: 
=4*9 
 
Press the Enter key and you will see the result displayed in the cell. 
 
Save your changes and close the workbook. 
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Formula error messages 
 
When writing formulas it is easy to make a mistake: listed below are some common error messages. 
 
####### 
The contents of the cell cannot be displayed correctly as the column is too narrow. 
 
#REF! 
Indicates that a cell reference is invalid. This is often displayed when you delete cells which are involved in a 
formula. 
 
#NAME? 
Excel does not recognise text contained within a formula. 
 
#DIV/0! 
This indicates that you have tried to divide a number by zero (0). 
 
 
Relative cell referencing within formulas 
 
Open a workbook called Cell referencing. 
The first worksheet within the workbook lets us look at relative addressing. 
Click on cell E4.  We need to insert the formula for multiplying items in column C by the items in columns D.   
 
Type in the following formula: 
=C4*D4 
 
Press the Enter key and you will see the result of the calculation in cell E4. 
Click on cell E4, and move the mouse pointer to the bottom-right corner of cell E4, and when the pointer 
changes to the shape of a small black cross, press the mouse button, and keep it pressed down.  Drag down 
the page to cell E12 and then release the mouse button. 
 
If you click on cell E5 you will see the following =C5*D5 
If you click on cell E6 you will see the following =C6*D6 
If you click on cell E7 you will see the following =C7*D7 
If you click on cell E8 you will see the following =C8*D8 
If you click on cell E9 you will see the following =C9*D9 
If you click on cell E10 you will see the following =C10*D10 
If you click on cell E11 you will see the following =C11*D11 
If you click on cell E12 you will see the following =C12*D12 
 
As you can see the referencing is completely relative.  This will become clearer when you have worked 
through the rest of this section. 
 
 
Absolute cell referencing within formulas 
 
Click on the Absolute tab at the bottom of the worksheet. 
Click on cell D4.  We need to enter a formula that will take the price and then add 5% to the price to give a total 
value.   
 
The 5% figure has been entered into cell C15. 
 
Type in the following formula into cell D4. 
=C4*C15 
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If you do the sums, you will find that this formula displays the correct delivery charge price in cell D4. 
 
Click on cell D4, and move the mouse pointer to the bottom-right corner of cell D4, and when the pointer 
changes to the shape of a small black cross, press the mouse button, and keep it pressed down.  Drag down 
the page to cell D12 and then release the mouse button.  The data will look something like this. 
 

 
 
 As you can see something has gone very wrong, as the 5% delivery charge appears to be 0 for most of the 
items. 
 
Click on cell D5 and you can see what the problem is.  The formula contained within this cell is:  
=C5*C16 
 
Part of the cell reference points to cell C16 (which if you check is empty).  The problem is that because of the 
relative nature of the formula, the component that should always refer to the contents of the cell in C15 (i.e. 
the delivery charge percentage), in fact moves down as you drag down the screen to extend your calculations. 
 
Select the range D4:D12 and press the Del key to delete the cell contents. 
 
Click on cell D4 and we will try again.  This time type in the following formula. 
=C4*$C$15 
 
The dollar signs make the reference to cell C15 absolute. 
 
Try extending the formula to fill the range down to D12.  This time you should find that the delivery charges 
are calculated correctly. 
 

  
 
TIP: You have seen relative and absolute referencing.  You can also have mixed references, which contain an 
absolute and a relative reference. 
 
Save your changes and close the workbook. 
  
 



72 
 

Functions 

What are functions ? 
A function allows you to calculate a result such as adding numbers together, or finding the average of a range 
of numbers.  Functions are located under the Formulas tab. 
 

  
 
 
Common functions 
 
Some commonly used functions include:  
 

  
 

AVERAGE: Used to determine the average value 
of the selected cells contents. 

COUNT: Used to count how many numbers are 
in the list. 

MAX: Used to return the maximum number from a list. 

MIN: Used to return the minimum number from a list. 

SUM: Used to add the contents of selected cells. 
 
This will display the Insert Function dialog box. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Scroll down the list which as you will see is extensive. 
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Sum function 
 
Open a workbook called Functions. 
If necessary, click on the Sum worksheet tab. 
 

  
 
Click on cell C8.   
 

  
 
In this cell we need to sum the values in the column above. 
 
Click on the Formulas tab and within the Function Library group click on the AutoSum icon. 
 

  
 
TIP: Click on the AutoSum icon, not the down arrow under or beside the icon. 
 
You will see the following displayed on your screen. 
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Press the Enter key and you will see the AutoSum result in cell C8. 
 

  
 
Click on cell C8, and you will see the function displayed in the bar just above your worksheet. 
 

  
 
As you can see the function is: 
 
=SUM(C4:C7) 
 
This function tells Excel to sum the values in the range C4:C7. 
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Average function 
 
Click on the Average worksheet tab. 
 

 
  
 
Click on cell C8.   
 

  
 
 
 
 
 
 
 
 
In this cell we want to display the average 
number of sales within the regions. 
Click on the Formulas tab and within the 
Function Library group click on the arrow 
under (or next to) the AutoSum icon.   
 

  
You will see a drop down list displayed.  
Click on the Average command. 
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You will see the following displayed on your 
screen. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Press the Enter key and you will see the 
average value displayed in cell C8. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on cell C8, and you will see the function 
displayed in the bar just above your worksheet. 
 

  
 
As you can see the function is: 
 
=AVERAGE(C4:C7) 
 
 
 
This function tells Excel to sum the average in 
the range C4:C7. 
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Max function 
 
Click on the Max worksheet tab. 
 

  
 
Click on cell C8.  In this cell we want to display the highest number of sales within a region. 
Click on the Formulas tab and within the Function Library group click on the down arrow under (or next to) 
the AutoSum icon.  You will see a drop down list displayed.  Click on the Max command. 
 

  
 
  
You will see the following displayed on your screen. 
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Press the Enter key and you will see the maximum value displayed in cell C8. 
 
  

 
 
Click on cell C8, and you will see the function displayed in the bar just above your worksheet. 
 

  
 
As you can see the function is: 
 
=MAX(C4:C7) 
 
This function tells Excel to display the maximum value within the range C4:C7. 
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Min function 
 
The MIN function will display the minimum number within a range. 
Click on the Min worksheet tab. 
 

  
 
Click on cell C8.  In this cell we want to display the lowest number of sales within a region. 
Click on the Formulas tab and within the Function Library group click on the down arrow under (or next to) 
the AutoSum icon.  You will see a drop down list displayed.  Click on the Min command. 
 

  
 
You will see the following displayed on your screen. 
 

  
 
Press the Enter key and you will see the minimum value displayed in cell C8. 
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Click on cell C8, and you will see the function displayed in the bar just above your worksheet. 
 

  
 
As you can see the function is: 
 
=MIN(C4:C7) 
 
This function tells Excel to display the minimum value within the range C4:C7. 
 
 
Count function 
 
The Count function will count up the number of cells which contain numbers. 
Click on the Count worksheet tab. 
 

  
 
Click on cell C19.  In this cell we want to display the number of cells in the column above that contain a number. 
Click on the Formulas tab and within the Function Library group click on the down arrow under (or next to) 
the AutoSum icon.  You will see a drop down list displayed.  Click on the Count Numbers command. 
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You will see the following displayed on your screen. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setup & Printing Issues 

 In all the previous examples, there was a 
column containing values immediately above 
the cell into which we inserted the function.  
In this case some of the cells within the 
column are empty and Excel, as you can see, 
has only applied the Count function to the 
range C17:C18.  The reason for this is that the 

next cell up, i.e. cell C16 is empty. 
 
 
We need to tell Excel that the range we are 
interested in actually extends from C5:C18. 
 
To do this, click on cell C18 and while holding 
down the mouse button drag up to cell C5.  Then 
release the mouse button. Your screen should 
now look like this. 
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Press the Enter key and you will see the count value displayed in cell C19. 
 

  
 
Click on cell C19, and you will see the function displayed in the bar just above your worksheet. 
 

  
 
As you can see the function is: 
 
=COUNT(C5:C18) 
 
This function tells Excel to display the number of cells containing a value within the range C5:C18. 
 
 
NOTE: If you made a mistake, click on cell C19 and press the Del key.  Then try again. 
 
Use the same technique to count up the number of people who could not attend, and display the value in cell 
D19. 
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The COUNTA function 
 
Used to count the number of cells within a range that are not empty. 
Click on the Counta worksheet tab. 
 

  
 
You will see data that contains a mixture of numbers (1) and letters (x).   
 

  
 
The Count function would only count up the number of cells containing numbers, whereas Counta will count 
the number of cells containing numbers and letters. 
Click on cell C19.Click on the More Functions icon (contained within the Function Library section of the 
Formulas tab). 
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From the drop down displayed, select Statistical.  From the submenu select Counta.   
 

  
 
This will display the Function Arguments dialog box, as illustrated. 
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If necessary move the dialog box 
to one side and then select the 
cell range C5:C18, as illustrated. 
 

 
 
 
 
 
 
 
 
 
 
 
 The Function Argument dialog 
box will look like this. 
 

  
 
 
 
 
 
 
 
 
 
 
 
Click on the OK button and you will see the 
following. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you can see the function has counted every instance of a number or letter within the specified cell range. 
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What are 'IF functions'? 
 
Excel has a number of functions which allow us to evaluate values and make decisions based on the result of 
the evaluation. The IF( ) FUNCTION is one of these. 
 
IF( ) SYNTAX 
The format (Syntax) of the IF( ) function is as follows: 
IF(LOGICAL_TEST, ACTION_IF_TRUE, ACTION_IF_FALSE) 
 
LOGICAL_TEST 
The logical_test evaluates an expression to see if it passes the test, i.e. is TRUE or does not pass the test, i.e. is 
FALSE 
 

  
 
ACTION_IF_TRUE 
Action_if_true can be a value or an operation. Whichever, the result is placed in the cell which contains the 
IF( ) Function if the logical_test is true. 
 
ACTION_IF_FALSE 
Action_if_false can be a value or an operation. Whichever, the result is placed in the cell which contains the 
IF( ) Function if the logical_test is false. 
 
Using the IF function 
 
Click on the If worksheet 
tab. 
 

  
In cells J8:J13 we need to display the word PASS or FAIL, depending on whether the average is over 70%. 
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Click on the cell J8. 
Click on the Logical icon within the Function Library group of the Formulas tab. 
 

  
 
This will display a drop down list.  Select the IF command. 
 

  
 
This will display the Function Arguments dialog box. 
 

  
 
In the LOGICAL_TEST section of the dialog box, we enter the logical test, i.e. I8>70 
 
In the VALUE_IF_TRUE section of the dialog box, we enter the word PASS. 
 
In the VALUE_IF_FALSE section of the dialog box, we enter the word FAIL. 
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Your dialog box will now 
look like this. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
Click on the OK button to 
continue.  Your screen will 
now look like this. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the normal Excel drag 
techniques to extend this 
function to the cells I9:J13.  
Your screen will now look like 
this. 
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Charts 

 

Inserting a column chart 
 
Open a workbook called Chart. 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
If necessary, click on the Column Chart worksheet 
tab (at the bottom-left of your screen). 
 

 
  

Click within the table 
of data. 
Click on the Insert tab 
and you will see the 
Charts group 
displayed within the 
Ribbon. 

 
 
Click on the Column icon and you will 
see a drop down displaying a range of 
column chart options. 
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Click on the first option, the 2-D Clustered format, as illustrated. 
 

  
 
You will see the following chart inserted into your worksheet. 
 

  
 
Click on the Undo icon (top-left of your screen), and experiment with inserting other types of column chart 
such as a 3-D chart, as illustrated below. 
 

NOTICE: 
Do not use 3-D chart unless it is required. 
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Inserting a line chart 
 
Click on the Line Chart worksheet tab at the bottom of your screen. 
 

  
 
Click within the data and then click on the Insert tab. Experiment with inserting different types of line chart, 
by clicking on the Line button.   
 

 
  
 
An example is illustrated below. 
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Inserting a bar chart 
 
Click on the Bar Chart worksheet tab at the bottom of your screen. 
 

 
  
Click within the data and experiment with inserting different types of bar chart, by clicking on the Bar button 
(under the Insert tab). 
 

 
  
An example is illustrated below. 
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Inserting a Pie Chart 
 
Click on the Pie Chart worksheet tab at the bottom of your screen. 
 

  
 
Click within the table of data. 
Experiment with inserting different types of pie chart.  
 

  
 
 
An example is illustrated below. 
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Resizing a chart 
 
Open a workbook called Chart Manipulation. 
 

  
 
Click on it to select it. 
Move the mouse pointer to one of the four corners of the chart.   You will notice that the mouse pointer 
changes to the shape of a diagonal line with an arrow at each end.  When you see the mouse pointer change, 
press the mouse button and while keeping the button pressed move diagonally across the screen.  Move 
away from the centre of the chart to make the chart larger and toward the centre of the chart to make the 
chart smaller.  When you release the mouse button the chart will be resized. 
 

 
  

Deleting a chart 
Select the chart and press the Del key. 
Save your changes and close the workbook. 
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Chart title or labels 
 
Open a workbook called Modifying charts. 
If necessary, click on the Modifying a Chart worksheet tab (at the bottom-left of your screen). 
 

  
 
You can see a column chart displayed within the workbook. Click on the chart title, as seen below. 
 

  
 
Press the Del key to remove the chart title.  Your chart will now look like this. 
 

  
 
To insert a chart title, click on chart and then click on the Layout tab.  Click on the Chart Title icon within the 
Layout Ribbon. 
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Select the required option from the drop down list displayed, such as Above Chart. 
 

  
 
 
Your chart title is once again displayed, as illustrated. 
 

  
 
TIP: To modify the chart title text, click within the Chart Title and simply edit the text in the normal way.  You 
can also apply text formatting to the Chart Title as required.  An example is shown below. 
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Changing the chart background colour 
 
Click on the chart to select it. Right click over an empty part of the chart background, and you will see a popup 
menu displayed. 
 

  
 
Click on the Format Chart Area command. 
 
TIP: If you do not see this command, right click on a different, empty part of the chart, until you do see this 
command. 
 
You will see the Format Chart Area dialog box displayed. 
 

  
 
If necessary, click on the Solid fill button and you will see extra controls displayed within the dialog box. 
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Click on the down arrow next to the Colour control and select a light colour from the options displayed. 
 

 
  
Click on the Close button to apply the colour, as illustrated below. 
 

  
 

Changing the column, bar, line or pie slice colours in a chart 
 
Click on the second worksheet tab, called Column Chart. 
 

  
 
Click on one of the columns within the chart. You should see all the columns are selected, as seen below. 
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Right click over one of the selected columns and from the popup menu displayed select the Format Data 
Series command.  
 

  
  
This will display the Format Data Series dialog box. 
 

  
 
Click on the Fill side tab within the dialog box, as illustrated. 
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If necessary, click on the Solid fill button. 
Click on the down arrow in the Colour section and select a colour for your columns. 
 

 
 
When you click on the Close icon the selected colour will be applied, as seen below. 
 

  
 

Click on the Line Chart worksheet tab and change the colour of the line. 
 
Click on the Bar Chart worksheet tab and change the colour of the bars. 
 
Click on the Pie Chart worksheet tab to 
display the pie chart.  The whole point of a 
pie chart is that each segment of the pie 
chart should be a different colour.  Bearing 
this is mind click once on the pie chart to 
select all the segments within the pie chart.  
Then click again on a particular segment to 
select just that segment.  At this point you 
can then right click and change the colour of 
just that segment.  An example is seen below. 
 

  
 
 

0

10

20

30

40

50

60

70

North South East West

Number of sales 

Number of sales

Number of sales 

North

South

East

West



101 
 

Modifying the legend fill colour 
 
Open a workbook called Legend. 
Select the legend within the chart, as illustrated. 
 

  
 
Right click over the selected legend and from the popup menu displayed select the Format Legend command. 
 

  
This will display the Format Legend dialog box, as illustrated. 
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Select the Fill side tab.  Select the Solid fill button and you will see the following. 
 

  
 
Click on the down arrow in the Colour control and select a colour as illustrated below. 
 

  
 
Click on the Close button to apply the formatting and close the dialog box. 
If you have time try experimenting with some of the other options within the Fill section of the Format 
Legend dialog box, such as Gradient Fills or adjusting the fill transparency. 
 

 
  
Save your changes and close the workbook. 
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Changing the Chart type 
 
Open a workbook called Changing charts.   
 

 
  
This workbook contains a column chart. Click on the chart to select it.  Click on the Design tab.  Click on the 
Change Chart Type icon displayed within the Type group of the Design Ribbon. 
 

  
 

This will display the Change Chart Type dialog box. 
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Select a different type of chart, such as a Bar chart. 
 

  
  
Click on the OK button.   
 

  
 
Experiment with applying different types of chart. 
Save your changes and close the workbook. 
 
Modifying charts using the Layout tab 
 
Open a workbook called Format Chart. 
Select the chart and then click on the Layout tab. 
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The Layout tab includes many options for controlling how the various chart elements are displayed. 
Click on the Chart Title button in the Labels group.   
 

  
 
A menu will be display allowing you to control where or if the chart title is displayed.  The default is Above 
Chart, try selecting the other options and observe the effect on the chart. 
 

  
 
 
NOTICE: 
A title of chart is placed at rhea bottom of chart. See p.118 for examples. 

 
 
Click on the Axis Titles button in the Labels group.  A menu will be displayed allowing you to control how the 
labels for each axis are displayed.  Experiment with some of the available options and view their effect on the 
chart. 
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Click on the Legend button in the Labels group.  A menu will be displayed allowing you to control where the 
chart legend is displayed.  Experiment with some of the available options and view their effect on the chart. 
 

  
 
Click on the Data Labels button in the Labels group.  A menu will be displayed allowing you to choose if labels 
should be applied to data in the chart.  Click on the Show option.   
   

  
 
 
The chart should now look like this. 
 

 
 
 Notice that each column is now labelled with its value. 
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Click on the Data Table button in the Labels group.  A menu will be displayed allowing you to show the data 
used to create the chart.  Click on the Show Data Table option. 
 

  
  

A small table will be displayed below the chart containing the relevant data. 
 

  
 

Click on the Gridlines button in the Axes group.  A menu will be displayed allowing you to control how the 
gridlines for each axis are displayed.  Experiment with some of the available options and view their effect on 
the chart. 
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Creating a combined line and column chart. 
 
Open a workbook called Line and column chart. 
 

  
 
 
 
Click within the table of data. 
Click on the Insert tab and within 
the Charts group click on the 
Column button. 
 

  
 
From the drop down list displayed, click on the first 2-D column chart option. 
 

  
 
A column chart will be inserted into the worksheet. 
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 Click on one of the columns within the chart that you wish to convert to a line rather than column. 
 

  
 
Right click over one of the selected columns and from the pop-up menu displayed, click on the Change Series 
Chart Type command. 
  

 
 
The Change Chart Type dialog box will be displayed. 
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Within the left-hand side of the dialog box click on the Line button. 
Select the first option within the Line formats displayed in the right section of the dialog box. 
Click on the OK button and you will now see a chart displayed using both columns and lines. 

  
 
NOTICE: 
Line chart are used to see a trend. This is just an 
exercise to change chart types.  
 
 
 
 
 
 
 
 
 

Save your changes and close the workbook. 
 
 

Adding a secondary axis to a chart. 
 
Open a workbook called Secondary Axis. 
 

  
 
 
Select the range B2:B11.  Hold down the Ctrl key and then also select the range E2:E11.  Release the Ctrl key. 
The selected data will look like this. 
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Click on the Insert tab and within the Charts group click on the Column button.  From the drop-down 
displayed select a 2-D Column chart format. 
 

  
 
A column chart will be created within the worksheet. 
  

 
 
This chart displays information about the number of unit sales per month.  We shall now add another data 
series which will use a secondary axis to display the relevant information. 
Select the range F2:F11. 
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Press Ctrl+C to copy the selected data to the 
clipboard. 
Click once on the chart to select it, press Ctrl+V to 
paste the selected data into the chart.  The chart will 
now look like this. 
 

  
 
 
 
 
 
 
Make sure the chart is selected. 
Within the chart click on one of the columns that you 
have just inserted. 
 

  
 
 
 
 
 
 
 
 
Click on the Format tab 
within the current selection 
group, click on the down 
arrow displayed at the top 
of the group. 
 

 
 

From the drop-down list displayed select 

Series ‘Total Sales Value’. 

  
 
 
 
 
 
 
 
 
 
Within the Current Selection group click on Format Selection. 
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The Format Data Series dialog box will be displayed.  Click on the Secondary Axis button.  Click on the Close 
button. 
 

  
 
The chart will now look like this. 
  

 
 
Right click on any part of a column relating to the Number of Sales. 
From the pop-up menu displayed click on the Change Series Chart Type command. 
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The Change Chart Type dialog box will be displayed.  Select a line chart type. 
 

  
 
Click on the OK button and the chart will now look like this. 
 

  
 
Save your changes and close the workbook.  
 

Changing the chart type for a particular data series. 
 
Open a workbook called Chart Types. 
Click on the second data series within the chart (in the example illustrated we clicked on one of the columns, 
representing the data for the West sales region). 
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Right click and you will see a pop-up menu displayed. 
 

  
From the pop-up menu displayed, select Chart Series Chart Type.  This will display the Change Chart Type 
dialog box.  
Select the required chart type, and if necessary chart sub-type.  In this case, select a Line chart. 
 

  
 
Click on the OK button to change the chart type, as seen below. 
  

 
 
Experiment with applying other chart types.  
Save your changes and close the workbook. 
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Adding a data series to a chart. 
 
Open a workbook called Adding a Data Series. 
This workbook contains a chart that is only displaying 
information relating to the East region. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can select a data range from 
your worksheet and add this to the 
chart.  To add information related to 
the West region to the chart we 
need to select the data relating to 
the West region, as illustrated. 
 

  
 
 
 
Press Ctrl+C to copy the selected data to the Clipboard. 
Click on the chart to select it and press Ctrl+V to paste 
the data to the chart.  The chart will now look like this. 
 

  
 
Save your changes and close the workbook. 
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Removing a data series from a chart. 
 
Open a workbook called Deleting a Data Series.  This workbook contains a chart. 
 

  
 
To delete a data series from the chart, click on one of the columns (representing the data series that you wish 
to remove).  In the example illustrated, we clicked on the sales data for the sales from the West region, (i.e. 
the yellow column). 
 
 Press the Del key.  The result will be as seen below. 
 

  
 
Save your changes and close the workbook. 
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Re-positioning chart title. 
 
Open a workbook called Moving Chart Titles.  The chart within the workbook looks like this. 
 

  
 
To move the chart title, first click on the chart title to select it, as illustrated. 
 

  
 
Move the mouse pointer to the edge of the chart title and drag the title to a new location. 
 

 
  

 
Save your changes and close the workbook. 
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Re-positioning the chart legend. 
 
Open a workbook called Moving Chart Legends.  The chart within the workbook looks like this. 
 

  
 
Click on the chart legend to select it, as illustrated. 
 

  
 
Move the mouse pointer to the edge of the chart legend, and drag the legend to a new location, as in the 
illustration. 
  

 
 
Save your changes and close the workbook. 
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Moving and formatting chart data labels. 
 
Open a workbook called Moving Chart Data Labels.  The chart within the workbook looks like this. 
  

 
 
Click on the chart data label, for the 2009 columns, to select them, as illustrated. 
 

  
 
Right click over a selected data label and from the pop-up menu displayed click on the Format Data Labels 
command. 
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This will display the Format Data Labels dialog box. 
 

 
    
 
Click on the Alignment tab. 
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Use the various options available to 
reposition the data labels within the 
chart.  For instance use the Custom 
Angle section within the dialog box 
to display the text at 45 degrees. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
If you click on the Close button the 
chart will look like this. 
 

  
 
 
 
 
 
 
 
 
 
 
Experiment with applying 
other formatting options.  
For instance, within the 
Format Data Labels dialog 
box, you can click on the Fill 
tab and apply fill formatting 
to the data labels. 
 

  
 
 
 
 
 
 
 
To move a data label, simple select the label and drag it to a new location.  Experiment with moving the data 
labels so that they are displayed half way up the columns, rather than being displayed at the top of each 
column. 
When you have finished experimenting, save your changes and close the workbook. 
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Modifying chart axis scales. 

 
Open a workbook called Chart axis scale. 
 

 
  

 
Click once on the vertical axis so that it is selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right click on the selected vertical axis and from the pop-up menu displayed, click on the Format Axis 
command. 
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The Format Axis dialog box will be displayed.  You can use this dialog box to set minimum and maximum axis 
values as well as specifying the major and minor axis scale units. 
 

  
 
Within the Minimum text box, click on the Fixed button and enter the number 50. 
Within the Maximum text box, click on the Fixed button and enter the number 300.  The dialog box will look 
like this. 
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Click on the Close button and the chart will look like this. 
 

  
 
Redisplay the Format Axis dialog box.   
Within the Major unit section, click on the Fixed button and enter the number 100. 
Within the Minor unit section, click on the Fixed button and enter the number 50.  The dialog box will look like 
this. 
 

  
 
Click on the Close button and the chart will look like this. 
 

  
 
Save your changes and close the workbook. 
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Formatting an axis to display using commas. 
 
Open a workbook called Chart 
axis units.  The chart looks like 
this.  Notice that neither the data 
in the table, or numbers within 
the vertical axis, use comma 
formatting. 
 

  
 
 
 
 
Select the vertical axis. 
 

  
 
 
 
 
 
 
 
 
 
Right click on the vertical axis and from a pop-up 
menu displayed click on the Format Axis 
command. 
 

  
 
 
 
 
 
 
 
 
The Format Axis dialog box will be displayed.  
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Click on the Number button displayed within the left 
side of the dialog box. 
Within the Category section, select Number. 
Click on the Use 1000 separator check box. 
Within the Decimal places section of the dialog box, 
enter 2. 
The dialog box will now look like this. 
 

  
 
  
 
 
 
 
 
 
 
 
 
 
Click on the Close button and your chart will 
look like this. 
  

 
 
 
 
 
 
 
 
 
Even though the numbers within the table of data are not comma formatted, the numbers within the vertical 
axis do use comma formatting.  This makes the chart easier to read and understand. 
Save your changes and close the workbook.  
 
 

Inserting images into chart columns. 
 
Open a workbook called Chart Columns with 
Images. 
 
Click on one of the columns within the chart, so 
that all 3 columns are selected. 
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Right click over the selected 
columns and from the pop-up 
menu displayed click on the Format 
Data Series command. 
  

 
 
 
 
 
 
 
 
 
This will display the Format Data Series 
dialog box. 
Click on the Fill option. 
Click on the Picture or texture fill button. 
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Basic Statistics with Excel 

 

 Statistics is the science of collecting, organizing, presenting, analysing, and interpreting numerical data for 
the purpose of assisting in making a more effective decision.  

 

 Statistical techniques are used extensively by marketing, accounting, quality control, consumers, 
professional sports people, hospital administrators, educators, politicians, physicians, etc... 

 

 Descriptive Statistics: Methods of organizing, summarizing, and presenting data in an informative way. 
 

 EXAMPLE 1: A Gallup poll found that 49% of the people in a survey knew the name of the first book of the 
statistical package. The statistic 49 describes the number out of every 100 persons who knew the answer. 

 

 EXAMPLE 2: According to Consumer Reports, Whirlpool washing machine owners reported 9 problems per 
100 machines during 1995. The statistic 9 describes the number of problems out of every 100 machines. 

 

 Qualitative or Attribute variable: the characteristic or variable being studied is nonnumeric. 
 

 EXAMPLES: Gender, religious affiliation, type of automobile owned, state of birth, eye Colour.  
 

 Quantitative variable: the variable can be reported numerically. 

 EXAMPLE: balance in your checking account, minutes remaining in class, number of children in a family.  
 

 Quantitative variables can be classified as either discrete or continuous. 
 

 Discrete variables: can only assume certain values and there are usually “gaps” between values. 

 EXAMPLE: the number of bedrooms in a house. (1,2,3,..., etc...). 
 

 Quantitative Variables can be classified as either discrete or continuous.  

 Continuous variables: can assume any value within a specific range. 

 EXAMPLE: The time it takes to fly from Toledo to New York. 
 
 

How to access Statistical Functions  
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Getting more statistics power from Excel 
  
To get more statistics power from Excel, you need to add in the Analysis Tool Pak 
Add in the Analysis Tool Pak 
Click the Microsoft Office button, then Excel Options. 
  

 
  

 
 

Click the checkbox for the Analysis Tool Pak, then ‘OK’ 
Install it if it isn’t installed 
When you have added it in, it will appear on the ‘Data’ page 
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Statistical Functions  

 
COUNT 
Open a workbook called Functions - Count.  This sheet contains examination results and grades. 
 

 
 
Click on cell C9. 
Click on the Formulas tab and within the Function Library group click on the More Functions button.  From 
the drop down list displayed click on Statistical.  From the submenu displayed click on the COUNT function. 
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The Function Arguments dialog box is displayed. 
  

 
 
In the Value1 section of the dialog box, Enter the cell range C5:C8. 
 

 
 
 
Click on the OK button to insert the function.  
Your worksheet will now look like this. 
 

  
 
 
 
 
 
 
 
You can see the function syntax displayed within 
the Formula Bar. 
 
=COUNT(C5:C8) 
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Use the normal drag and drop techniques to copy this function to cells D9 and E9.  Your worksheet will now 
look like this. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Save your changes and close the workbook. 
 

 
 
RANK 
 
Open a workbook called Functions - Rank.  
The worksheet contains a table of sales 
results, including the total number of 
individual sales and also the total value of 
sales made, by all ten sales people working 
for a company. 
 

  
 
 
 
 
 
 
We want to rank each sales person by total number of sales made and also by the total values of sales made. 
Click on cell E4. 
Click on the Formulas tab and within the Function Library group click on the More Functions button.  From 
the drop down list displayed click on Statistical.   
 
You will notice that the 
Rank function is not 
displayed within the list. 
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Click on the Insert Function button and type the word Rank into the search box. 
 

  
 
Click on the Go button (not the OK button) and you will see the following dialog box. 
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Read the information displayed at the bottom of the dialog box. 
With the Rank function selected, click on the OK button. The Function Arguments dialog box will be displayed. 
 

  
 
Enter the following data.   
 
In the Number section we specify the item to rank, in this case C4.   
 
In the Ref section we specify the range from which to compare the ranking value, in this case: $C$4:$C$13. 
 
Your dialog box will look like this. 
 

  
 
TIP: Within the Order section, if we do not enter a value, or if we enter a 0, then the rank will be sorted in 
descending order.  If we wanted to sort in ascending order, you would enter any number other than 0.  In this 
example we will not enter a value, so the ranking will use the default descending order. 
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Click on the OK button.  You will see the following.  This means that Hastert, ranked in position 9, compared 
to the other sales people, in terms of the total number of sales made. 
 

  
 
Drag the contents of cell E4 to fill the range E4:E13.  Your data will now look like this.  If you look closely you 
will see that Gravani and Mach are in joint place.  This explains the fact that there is no sales person listed in 
second place.  After the two joint-first position, the next best ranking in Feeney in rank position 3. 
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We will now see how the sales people rank in terms of total sales.  Some sales people are very good at selling 
a lot of low value items, while other sales people specialise in making fewer, but higher value sales. 
 
Click on the cell F4. 
 
Re-display the Function Arguments dialog box for the Rank function and enter the following data. 
 
Number: D4 
Ref:  $D$4:$D$13 
 

  
 
Click on the OK button.  Your data will look like this. 
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Extend the contents of cell F4 to fill the range F4:F13.  Your data will now look like this. 
 

  
 
As you can see Hastert, despite not making very many individual sales, actually is in the top ranked position 
when it comes to the total value of the sales made.  You will notice that there are 2 sales people with the 
number three ranking, which is why there is no sales person listed in the number four ranking spot. 
 
Save your changes and close the workbook. 
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Passwords & Security Issues 

 

Adding password protection to a workbook. 
Open a workbook called Opening password 01.  We wish to add a password to prevent unauthorised access to 

this file. 
 
  
 
 
 
 

 
Click on the File tab and select 

the Save As command.   
 

  
 
 
 
 

 
 

• This will display the Save As dialog box. 
 

Click on the Tools link, and from the drop down list 
displayed select the General Options command. 

 

 
  
 
This will display the General Options dialog box. 
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Enter a password (in this case cct) into the Password to open text box.  In future, you will be required to enter 
this password in order to open the file. 

 

  
 
Click on the OK button. You will be asked to re-type the password.   
 

  
 
Re-enter the password, and click on the OK button to close the Confirm Password dialog box. 
You will be returned to the Save As dialog box.  Click on the Save button.  You will be asked if you wish to 

overwrite the original file.  Click on the Yes button  
 

  
Close the workbook. 
Re-open the workbook.  You will see a dialog box, into which you must enter the correct password, i.e. 'cct'.  

Do this and the workbook should open. 
 
 
 

 

 

 

 

 

Adding 'modify' password protection to a workbook. 

Open a workbook called Modification password 01.   
We wish to save this file so that when opened it will display a dialog box, explaining 
that you should normally open this worksheet as a read-only file, i.e. one where 
modifications may be made, but where you cannot overwrite the original file.  Any 
changes would have to be saved in a file with a different name. 
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Click on the File tab and select the Save As command.   
 

 
  
 
This will display the Save As dialog box.   
 
Click on the Tools link, and from the drop down list displayed select the General Options command. 
 

  
 
 
This will display the General Options dialog box. 
 

  
 
Enter a password (in this case cct) into the Password to Modify text box.  In future, you will be required to 

enter this password in order to open and modify the file. 
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Click on the OK button. You will be asked to re-type the password. 
 

 
 
Re-enter the password, and click on the OK button to close the Confirm Password dialog box. 
You will be returned to the Save As dialog box.  Click on the Save button.  You will be asked if you wish to 

overwrite the original file.  Click on the Yes button  
 

  
 
Close the workbook. 
Re-open the workbook.  You will see a dialog box displayed. 
 

  
 

If you enter the correct password, you can open and edit the document.  If you do not supply the correct 
password, you can only open and view the document. 
 
NOTE: Without the password you can still open and edit the document, but you must save the workbook 
using a different filename.  You will not be allowed to overwrite the original version of the document. 

 
Close your workbook. 
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Removing an password from a workbook. 

Open a workbook called Opening password 02. 
This workbook has been protected with a password that prevents opening the workbook, unless you enter 

the correct password.  You will see a Password dialog box displayed.  
 

  
 
Enter the password (in lower case) which is. 

cct    
 

and then click on the OK button to open the 
file. 

 
Click on the File tab and select the Save As 

command.   
 
 This will display the Save As dialog box. 
 

 
 

  Click on the Tools link, and from the drop down list displayed select the General Options command. 
 

  
 
 
 
 
 
 
 

This will display the General Options dialog box. 
 

  
 
Delete the password and then click on the OK button. 
Save and close the workbook. 
Reopen the workbook and you will see that the password has been removed. 
Close the workbook. 
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Removing a 'modify' password from a workbook. 

Open a workbook called Opening password 03. 
This workbook has been protected with a 'modify' password.  You will see a Password dialog box displayed.  
 

 
  
Enter the password (in lower case) which is.  
cct    
and then click on the OK button to open the 
file. 
 
Click on the File tab and select the Save As 
command.   
 
This will display the Save As dialog box. 

 
Click on the Tools link, and from the drop down list displayed select the General Options command. 
 

  
 
This will display the General Options dialog box. 
 

  
 
Delete the password and then click on the OK button. 
Save and close the workbook. 
Reopen the workbook and you will see that the password has been removed. 
Close the workbook. 
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Setup & Printing Issues 

 
Worksheet margins 
Open a workbook called Print setup. 
Click on the Page Layout tab, and from within 
the Page Setup group, click on the Margins icon. 
 

  
 
This will display a drop down from which you can 
select Normal, Wide or Narrow.  
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
Clicking on the Custom Margins command displays the 
Margins tab within the Page Setup dialog box.  You 
can use this dialog box to set custom top, bottom, left 
and right margins. 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
TIP: You can also use this dialog box to set Header and Footer values, as well as options to centre the table on 
the page vertically and/or horizontally. 
 
Experiment with setting margins.   
 
TIP: Be sure not to make the margin size too small or you may have problems printing the worksheet. 
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Worksheet orientation 
 
Click on the Page Layout tab, and from within the Page Setup group, click on the Orientation icon.   
 

  
 
You can select either Portrait or Landscape orientation, as illustrated. 
 

  
 
Try setting the orientation to Landscape.  To see the effect in Print Preview mode, press the Ctrl+F2 keyboard 
shortcut.   
 

  
 
To return to the normal view, click on the Home tab. 
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Worksheet page size 
 
Click on the Page Layout tab, and from within the Page Setup group, click on the Size icon.   
 

  
 
You can select the required page size from the drop down options displayed, as illustrated. 
 

  
 
 
 
Headers and footers 
 
Click on the Insert tab and from within the Text group, click on the Header & Footer icon. 
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You will see the Header area displayed at the top of the worksheet, as illustrated. 
 

  
 
Type in the text for your header, such as Stock Levels for January. 
If you scroll down the page you will see the message 'Click to add footer' displayed at the bottom of the 
worksheet. 
 

  
 
Click within the footer area and type in your name.  As example is illustrated below. 
 

  
 
To modify a header or footer at any time just click over an existing header or footer and edit as required.  
 
 
Header and footer fields 
 
When you are inserting or editing a footer or header, you will notice that you see the Header and Footer Tools 
Ribbon.  Within this Ribbon is the Header & Footer Elements group, as illustrated below. 
 

  
 
You can use the icons in this section in insert an Excel field, such as the Page Number.  The great thing about 
fields is that they automatically update when required.  For instance if you insert a Page Number field, then as 
you add more pages, the page number displayed on each page will increment. 
Another very useful field is the File Name field.  This displays the file name of the document in your header or 
footer, when you print, and is very useful when you have printed out a copy of a worksheet and then several 
months later are trying to remember the file name you used to save the worksheet as.  
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NOTE: When you insert a field, such as the File Name field, you may see the field code rather than the actual 
file name.  When you print the worksheet however, this code is replaced by the actual file name. 
 
The File Path will display the file name and also the path to the folder in which the file is stored. 
Experiment with inserting different fields into your header or footer.  
 
Make sure that you have experimented with all of the following field types:  
 
Page numbering:   

 
 
Date:   

 
 
Time:  

  
 
File name:  

  
 
 
Worksheet name:  

  
 
 
NOTE: To remove a header or footer field, select the field and press the Del key. 
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Scaling your worksheet to fit a page(s) 
 
Click on the File Tab and then click on the arrow next to the Print side tab.  Click on the down arrow next to 
the Scaling section. 
 

  
 
The list displayed allows you to select print scaling options, such as Fit Sheet on One Page. 
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You can see that when this 
option is selected the sheet 
does, as expected, fit onto one 
page. 
 

  
 
 
 
 
 
 
 
 
 
You can also customise how many pages 
you would want the data to fit on.  To do 
this click on the Custom Scaling Options 
button. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
This will display the Page Setup dialog box, 
which you can use to customise scaling of the 
printing. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save your changes and close the workbook. 
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